SCC Inc. Installation Instructions

Document No. TS-1100
February 14, 2017

TS Series

TS... Touchscreen Kits
for use with LMV3, LMV5 and RWF... Controls

Touchscreen Plate Kit

Description
TS... series touchscreen kits provide a human machine interface

(HMI) when used with a Siemens LMV3 or LMVS5 linkageless
control. Each kit provides boiler burner data collection and
trending for a hydronic or steam boiler. An optional RWF...
control for load or water level modulation easily interfaces with
a TS... series touchscreen kit.

Each TS... touchscreen kit includes a 6” or 10” touchscreen along
with a plate kit to be mounted inside a control panel (by others).

A PLC first-out annunciator option is available for additional
analog, digital, and temperature inputs.

Flexible communication interface options to the building
management system (BMS) provide streamlined data collection
and monitoring.
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TS Series

Compatible Controls and Accessories

Controls
e LMVS5... with internal load controller
e LMV5... with RWF40 or RWF55 external load controller
e LMV3... with RWF10, RWF40 or RWF55 external load controller

Accessories
e Feedwater control via RWF40 or RWF55 (steam boilers only)
e Connection to SCC-supplied variable speed drives (combustion air fan)
e SCCInc. Expanded Annunciation system

Page 4
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Physical Connections

The touchscreen communicates with the connected equipment via Modbus. Use the supplied

terminal connections provided with the plate kit to wire the touchscreen, plate kit, and

controllers. Connect any RS-485 devices in a daisy-chain with termination at the end of the
chain (typically a 120-Ohm resistor). The following addresses are required for the connected

equipment:

Table 1: Required Addressing of Controllers

Device I:e dq durI:: Communication Type
LMV3x (via OCl412.10) 1 Modbus RTU (RS-485)
LMV5x 1 Modbus RTU (RS-232)
RWF10 (for load control) 2 Modbus RTU (RS-485)
RWF40 (for load control) 2 Modbus RTU (RS-485)
RWEF55 (for load control) 2 Modbus RTU (RS-485)
RWF40 (for feedwater) 3 Modbus RTU (RS-485)
RWEF55 (for feedwater) 3 Modbus RTU (RS-485)
VSD 31 Modbus RTU (RS-485)
Expanded Annunciator N/A Modbus TCP/IP (Ethernet)

Communication via Modbus must be set with the following values:

e 19200 baud

e 8stop bits
e 1 data bit
e no parity

See the appendices for Modbus configuration details for each device.

SCC Inc.
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Logging In

When the touchscreen is powered up, the OVERVIEW screen will appear.

07/16/15 08:50

-12- STANDEY STATIONARY

Dxygen20 9%

STARTUPS:1126
- HOURS: 526

Press MAIN MENU in the lower left corner to go to the MAIN MENU screen.

D7/165/15 0851

I OUT DETAIL

From here, different screens can be accessed depending on the access level. There are three
access levels available:
e USER: Allows access to viewing data, changing setpoints, and manual operation. No
username or password required.
e TECH: Same access as USER level as well as access to changing operational parameters.
Username and password required. The username is TECH. The default password is
9876.
e SETUP: Same access as TECH level as well as access to programming touchscreen
configuration settings. Username and password required. The username is SETUP. The
default password is START.

NOTE: If the ACTIVATION screen appears instead of the OVERVIEW screen, see the Activation
section for additional detail.

Page 6 SCCInc.
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Logging In (continued)

In order to log in at the desired access level, press LOG IN. The LOGIN screen will appear.

TRENDS : : LOG IN

Use the keypad to enter the username for the desired access level. When finished, press
ENTER.

Next, tap the area next to PASSWORD and the same keypad will appear again. Enter the
password and then press ENTER.

When both the username and password have been entered, press APPLY. If successful, the
CURRENT USER will change from USER to TECH or SETUP depending on the username and
password that were entered. Hit CLOSE to leave the login screen.

SCCInc. Page 7
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TS Series

Configuration

Access level: SETUP

The touchscreen needs to be configured for the connected equipment. Once logged in at the
SETUP level, the LOG IN button will now read LOG OUT.

Press SETTINGS to display the SETTINGS screen, then press OPTIONS to display the OPTIONS

screen.

Lil DATA

SETTIMNGS

07/16/15_

LOCAL SETPOINT:

FROFORTIOMNAL:
INTEGRAL:

DERIMATIVE:

LMWE OF MODE:

93

10.1%

Page 8
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Configuration (Options)

On the OPTIONS screen, the touchscreen is configured for the components it is connected to,
including the type of boiler, the controller(s), and more.

07/16/15 0910 o7/16/15] _ oprions [l o505 ]
CONTROLS: CONTROLS: o
TYPE: stniard

LOCK FOR CONTROL BY LEAD/LAG: No _ LOCK FOR CONTROL BY LEAD/LAG:

conTROLS: || LMuzs/Ruvrss [ ArtFuel | e[ Disabled | CONTROLS: || LktvS Only | EA
: EXTRA FUSF

TYPE: || Hydronic Standard

_ LOCK FOR CONTROL BY LEADSLAG: Mo _ LOCK FOR CONTROL BY LEAD/LAG: M

Different options will appear on the screen depending upon the controller selected.

SCCInc. Page 9
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Configuration (Options continued)

CONTROLS - Choose which Siemens controller(s) are connected to the touchscreen.

e LMV5x Only: Select this option when using an LMV5x and its internal load controller.

e LMV5x/RWF40: Select this option when using an LMV5x with an RWF40 as an external
load controller.

e LMV5x/RWF55: Select this option when using an LMV5x with an RWF55 as an external
load controller.

e LMV3x Only: Select this option when using an LMV3x with no load controller.

e LMV3x/RWF10: Select this option when using an LMV3x with an RWF10 as an external
load controller.

e LMV3x/RWF40: Select this option when using an LMV3x with an RWF40 as an external
load controller.

e LMV3x/RWEF55: Select this option when using an LMV3x with an RWF55 as an external
load controller.

CONTROLS (when LMV3x selected) — Select the actuators being used on an LMV3x controller.
e None
e Air Only: Choose this option when only an air actuator is being used.
o Fuel Only: Choose this option when only a fuel actuator is being used.
e Air & Fuel: Choose this option when both air and fuel actuators are being used.

TYPE (1) — Choose the type of boiler that the touchscreen is connected to. This is configured
automatically to match the local AZL when the control is an LMV5x.

e Hydronic: Select this option for a hot water boiler.

e Steam: Select this option for a steam boiler.

TYPE (2) — Choose the units.
e Standard: Process variables are shown in standard units (degrees Fahrenheit, PSI).
e Metric: Process variables are shown in metric units (degrees Celsius, BAR).

FDWATER - Choose whether a feedwater system is installed with a Siemens controller (only
shows up for steam boilers).

e Disabled

e RWF40: Select this option if the feedwater is being controlled by an RWF40.

e RWEF55: Select this option if the feedwater is being controlled by an RWF55.

Page 10 SCCInc.
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Configuration (Options continued)

PUMP - Select whether the boiler circulating pump is controlled by the EA (only shows up for
hydronic boilers with EA optioned).

e Disabled

e Enabled

VSD — Select whether an SCC-supplied VSD system is installed on the combustion air fan.
e Disabled
e Yaskawa: Select this option if the SCC-supplied VSD system is manufactured by Yaskawa.

LINK RWF — Select whether Modbus commands to an LMV are redirected to the corresponding
RWFxx load controller (requires > 1s press).

e No

e Yes

LMV3 EC (when LMV3x selected) — Select how LMV3x error codes are represented via Modbus
(requires > 1s press).

e LMV3 Codes Directly: LMV3x codes are not manipulated.

e LMV5 w/Embedded LMV3: LMV3x codes are converted to corresponding LMV5x codes
(when possible, otherwise code '43' is used) and the original LMV3x codes are transmitted
as the diagnostic code.

e LMVS5 w/Diag Code 0: Same as above, except '0' is transmitted as the diagnostic code.

GAS/OIL (FUELO/FUEL1) — Sets the tag name for the fuel (up to six characters) and selects
whether the fuel should represent a blue or an orange flame.

EA - Select whether the Expanded Annunciator option is present.
e Disabled
e Enabled

EXTRA RWF - Select whether additional RWF55 controls are connected serially via RS-485 to
the Expanded Annunciator (only shows up when EA optioned, standard EA feature).

e None

e 1x RWF55: Use Modbus address 1, 19200 baud, 8 stop bits, 1 data bit, no parity.

e 2x RWF55: Use Modbus addresses 1 & 2, 19200 baud, 8 stop bits, 1 data bit, no parity.

RTD - Select whether the RTD input option is enabled in the Expanded Annunciator (only shows
up when EA optioned, requires RTD input option).

e Disabled

e Enabled

SCCInc. Page 11
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Configuration (Options continued)

ANALOG - Select whether the analog input option is enabled in the Expanded Annunciator
(only shows up when EA optioned, requires RTD input option).

e Disabled

e Enabled

ECONOMIZER - Select whether the economizer option is enabled in the Expanded Annunciator
(only shows up when EA optioned, requires RTD input option or economizer RTD input option).
o Disabled
e Enabled: Uses economizer RTD input option for temperature sensors. The LMV5x stack
temperature sensor may be used for one of the inputs.
e Use RTD: Same as above, but uses the regular RTD input option for the economizer.
Setting this option will automatically set the RTD option to Enabled.

DRAFT - Select whether the draft control option is enabled in the Expanded Annunciator (only
shows up when EA optioned, requires analog input option and RTD input option).
e Disabled
e Enabled: Uses three EA digital inputs for status, one RTD input for resistance feedback
and one analog input for the draft sensor. Setting this option will automatically set the
ANALOG and RTD options to Enabled.

0O, (when LMV5x selected) — Select whether the O, and efficiency are calculated using the dry
or wet method.
e Dry: The dry basis O, trim data (efficiency, O,) is calculated from the wet basis O, trim
data supplied by the LMV52. CO, and excess air are also calculated.
e Wet: The wet basis O, trim data (efficiency, O,) is supplied by the LMV52.

TAG — Sets the tag name for the boiler (up to six characters).

LOCK FOR CONTROL BY LEAD/LAG — Set automatically by the Lead/Lag Master to allow remote
configuration when connected. Can be overridden when no longer connected to Lead/Lag
Master (requires > 1s press).

e No

e Yes

Page 12 SCCInc.
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Configuration (Language, Color / Shape)

Press SPANISH/ESPANOL to change the language from English to Spanish.
Press ENGLISH/INGLES to change the language from Spanish to English.

LMWS OF MODE:

Press COLOR/SHAPE to pull up the current image of the boiler and burner. This sets the visual
representation for the boiler vessel and burner on the OVERVIEW screen.

i 5
LOCAL SETPOIN
PROPORTIOMNA
INTEEG R
DERMATIV
LMuwE OF MODE: LMwE OF MOD
Y| Y| [Backue

Tap the boiler vessel portion of the image to scroll through the available choices boiler choices.
Tap the burner portion of the image to scroll through the available burner choices. When
complete press EXIT to confirm changes.

SCCInc. Page 13
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Configuration (Screen Settings)

Press SCREEN SETTINGS to adjust the touchscreen settings.

07715415 07715
Al SCREEN SAVE TIME: | 10m
LOCAL SETPOINT:[  38P3| _ LOCAL 55 B
E B sCREEN SAVE TYPE: [ mtus |
PROPORTIONAL:|  10.1% — FROFPOH o !
=ﬁ AUTD LOGOUT: 10m
| bt
DEHIUATI'U'E: DER| —MN YE’Q‘H:| b | H':""H:| 1B |
-E
. - MDN:| 7 |MIN:‘ 5 ‘
s
oouss apones: | ¥ o [l = [=]
[_EABASE CONFIG_] [ war || mR

SCREEN SAVE TIME - Select between off (no screen saver), Im, 2m, 5m, 10m, 30m or 60m.

SCREEN SAVE TYPE — Select the screen saver type.
e Status: Shows the process variable, setpoint and current status in a large font.

180°F

e Blank: Screen saver is a blank screen.

AUTO LOG OUT - Sets how long a user remains logged in. Select between 5m, 10m, 30m, 60m
or 120m.

BRIGHTNESS — Sets the touchscreen brightness.
TIME - Sets the touchscreen time. +1HR and -1HR buttons are available for quick changes.

Note that if the selected controller is an LMV5x, the time will automatically be set from the
LMV5x.

Page 14 SCCInc.
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Configuration (Saved Images)

Press SAVED IMAGES to view screen captures stored on the USB drive.

PROFPORTIONAL:
INTEGRAL:

DERIMATIVE:

LMYE OF MOD

07/18/16

50 HOFMAL OPERATION

PV BEPSI
SP 99FPSI

GAS

Ambient
i

¥iD To.%

Air
File Name:

A
551507 15000000 . JPG

[

Etficiency 94 5%

EIER

SCCInc.
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Configuration (Boiler Address)
Press BOILER ADDRESS to adjust the boiler address settings.
The boiler address is used to give a unique identifier to each boiler. This must be set if the

touchscreen is connected to a Lead/Lag Master or if multiple touchscreen kits are connected on
the same Ethernet network.

LOCAL SETPOINT:

PROFPORTIONAL: 10.1%

INTEGRAL:

- CURRENT ADDRESS IS BOILER 1
_ SITE HAME .

Press OTHER when a user-specific IP address is desired in standalone applications.

DERIMATIVE:

SUBNET:[

GATEWAY:

Press APPLY to confirm the changes.

SITE NAME - Sets the site name, which is used in the subject of email sent by the
touchscreen (up to 20 characters).

Page 16 SCCInc.



TS Series Installation Instructions

Document No. TS-1100

Configuration (Boiler Address continued)

Press CURRENT ADDRESS IS... to see the current IP address.

07/21/15

IP: 1921621 .60
SUBMET: 2559.255.255.0
GATEWAY: 192.182.1.1

BT

CUR
SITE NAME

| Touchscreen Kit

The default IP addresses for each device are listed below:

Boiler 1-192.168.1.60
Boiler 2 -192.168.1.61
Boiler 3-192.168.1.62
Boiler 4 —192.168.1.63
Boiler 5-192.168.1.64
Boiler 6 - 192.168.1.65
Boiler 7 - 192.168.1.66
Boiler 8 —192.168.1.67
Subnet - 255.255.255.0

SCCInc. Page 17
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TS Series

Configuration (Boiler Address continued)

The Expanded Annunciator comes with a default IP address 192.168.1.59. To change this, press

EXPANDED ANNUNCIATOR.

CURRENT ADDRESS IS BOILER 1
SITE HAME

Touchscreen Kit

CURRENT IP: 152.168.1.569
CURRENT SUBNET: 25b.2565.255.0
CURRENT GATEWAY: 192.168.1.1

NEW IP:| 192 | 188 | 1 | 59

NEW SUBMNET:| 255 | 255 | 285 | 0
NEW GATEWAY:| 132 [es | 1 [ 1

RESET TO T MATCH TO
DEFAULT APPLY NEW BOILER

CONNECT SERIAL LINK

Enter the desired IP address, then press APPLY NEW.

RESET TO DEFAULT - Sets the IP address back to 192.168.1.59. Once this is pressed it may take

up to two minutes for the Expanded Annunciator to load the change and reboot.

MATCH TO BOILER - Sets the IP address 10 below the boiler IP address. For example, if the IP
address of the boiler is 192.168.1.60, the Expanded Annunciator IP address will be
192.168.1.50. This is required when using Expanded Annunciators with a Lead/Lag Master.

Once this is pressed it may take up to two minutes for the Expanded Annunciator to load the

change and reboot.

Page 18
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Configuration (Boiler Address continued)

CONNECT SERIAL LINK — Use this when the communication to the Expanded Annunciator is not
possible due to a mismatched IP configuration or the IP address is unknown. This establishes a
temporary serial connection between the touchscreen and Expanded Annunciator for the sole
purpose of setting and synchronizing the IP address. To make the serial connection, use an
ordinary Cat5 or Cat6 Ethernet cable and connect it between 'COM1' on the touchscreen
(disconnect existing cable) and 'RJ45 Serial 1' on the Expanded Annunciator. When finished,
press DISCONNECT SERIAL LINK and reconnect existing cable to 'COM1' on the touchscreen.

07/ 21718 16:35 07 21718 16:36
CURRENT IP: 192.168.1.59 CURRENT IP: 192.168.1.59
CURRENT SUBNET: 2bh. 255 255.0 CURRENT SUBNET: 2bh. 255 255.0
CURRENT GATEWAY: 192 168.1.1 CURRENT GATEWAY: 192 168.1.1
NEW IP:| 13z 188 1 53 NEW IP:| 13z 188 1 53
NEW SUBMNET:| 2585 | 255 | 255 ] NEW SUBMNET:| 255 | 255 | 255 i
NEW GATEWAY:| 152 168 1 1 NEW GATEWAY:| 152 162 1 1
RESET TO MATCH TO RESET TO MATCH TO
DEFAULT AELEEW EOILER DEFAULT AELEEW EOILER
| _ | DISCONHECT SERIAL LINK

SCCInc. Page 19
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Configuration (Expanded Annunciator Base Config)

Press EA BASE CONFIG to configure basic Expanded Annunciator settings. Use the arrows to
scroll between the configuration pages.

LMWE OF MODE: ||

Page 20 SCCInc.
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Configuration (Expanded Annunciator Base Config)

Digital Inputs

[07/15/15 [ exeannen ann conric [ 1102 07/16/15 |_exeanoen ann conric [ 1111 ]
1-[operating Contral L] e [ reser: [[Au 2:[NoT UsED acarmt:[Nane | reser:[Auta |
2:[aute LcO [ acern: (RN Fese: [Caute 2:[not usen acarm:[Hone | reser:[CAute |
3:|Lowver Proven [ acern: [ Fese: [CAute tanoT UseD aLarm:[Hone | Feser:[[Aute |

EE

4:|NoT usED ALARM: | None | RESET:| Auto | 11 {Bamper Open oz ALARM:[[Hane | REsET:[CAuta |
& [noT useD aLarn: [ None | FESET: [FAuo | 12:|njaanj:érﬁcjo’;§_-9qfsjjjjj ALAHM: HESET:
& ot usen avarn: [Hane | FeseT: (R | t2Bamperign Pos. | AusRn:[Hans | Reser: [ |
7:|nor useo aLsrn: [ Hone | FESET: [ Auta |

LIMIT 1-13 — Sets the user-configured name for each limit. The name may be up to 20
characters long. Press X to clear the name and reset input configuration (requires > 1s press).

Note that limits 11-13 are locked out since they are being reserved for use with the draft
control option.

ALARM - Select how each individual limit will alarm. Alarms are subject to a short (five-second)
delay to ensure the alarm condition is present.
e None: Will not alarm regardless of the position the input is in.
e Is Off: Will alarm when the input is deactivated.
e Is On: Will alarm when the input is activated.
e FO Off: For first-out applications, will alarm when the input is deactivated only if the
previous input is activated (not available for limit 1).

RESET — Select the reset type for the alarm. Manual reset alarms may be reset by pressing
RESET EA ALARMS on the ALARMS page.

e Auto: Alarm will automatically reset.

e Manual: Alarm will require a manual reset.

Additional Digital Input Options

Assigning the name 'Alarm Reset PB' (case-sensitive) to any of the digital inputs will cause that
input to act as a reset button for the Expanded Annunciator. Use this option when a hard-
wired reset button is preferred.
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Configuration (Expanded Annunciator Base Config continued)

Monitored Digital Outputs

The monitored digital outputs can be configured to take an action based upon the value in any
of the Modbus registers. Each monitored digital output can consider two conditions using a
logical function. To enable or disable the second condition, touch the slider switch.

08/11./18 el 08/11./18 11:12

DIGITAL OUTPUT f MONITORED WALUE 3 DIGITAL OUTPUT J MONITORED WALUE 2
CONHDITION 1
IF MODEUS PxDDHESS| 54 I| 1 OUTFUT 15 ACTIVE WwHEN
LMY MINUTE

| COMDITION 1

ARD ‘ COMDITION 2
15 = SETFOINT 53.0

OFF . oH COMDITION 2
IFMDDBUSADDHESS| 53 I| 1

EMEERILIE LATCH = MO o
OFTIOMS: CURRENT = FALSE
I3 —  SETPOINT| 230 ALARR = RO

Conditions

AFFLY ‘ DEL&Y Ok DF| 405

IF MODBUS ADDRESS - Sets the Modbus register index to monitor and the divider to apply to
it. The name of the chosen address will then be displayed.

IS — Select the logic applied to the value. Can be <, <=, >, >=, = or a BIT comparison.

SETPOINT - Select the setpoint that the logic will be used to compare against. For bit
comparisons, setpoint must be the specific bit of the word (0-15) for the result to be accurate.

Page 22 SCCInc.



TS Series Installation Instructions
Document No. TS-1100

Configuration (Expanded Annunciator Base Config continued)
Logic

CONDITION - Select whether the condition is normal or inverted.
e CONDITION: Will apply the result of the condition.
e INVERTED CONDITION: Will apply the opposite of the result of the condition.

LOGIC - If two conditions are used, selects the logic applied between the conditions. See
Appendix - Logic Definitions for additional detail.

e AND: Will apply AND gate (and) logic.

e OR: Will apply OR gate (or) logic.

e NAND: Will apply NAND gate (negative and) logic.

e NOR: Will apply NOR gate (negative or) logic.

e XOR: Will apply XOR gate (exclusive or) logic.

e XNOR: Will apply XNOR gate (negative exclusive or) logic.

APPLY - Select whether any delay is applied to the output.
e NO DELAY: Will turn the output on or off immediately.
e DELAY ON: Will turn the output on only after the specified delay.
e DELAY OFF: Will turn the output off only after the specified delay.

(DELAY TIME) OF - Sets the delay setpoint in seconds.

OPTIONS - Select the additional output options. Latched outputs may be reset by pressing
ALARM RESET on the ALARMS page.
e LATCH = NO, ALARM = NO: Will not latch the output or generate an alarm with the
output.
e LATCH = YES, ALARM = NO: Will latch the output but will not generate an alarm with the
output.
e LATCH = NO, ALARM = YES: Will not latch the output but will generate an alarm with the
output.
e LATCH = YES, ALARM = YES: Will latch the output and will generate an alarm with the
output.

The current state of the logic is also displayed with true in green and false in red.
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Configuration (Expanded Annunciator Option Config)

Press EA OPTION CONFIG to configure optional Expanded Annunciator settings.

LMYS OF MODE:

Press V&mA and RTD to switch between types, and the arrows to scroll between the
configuration pages within the types.

ANALOG INPUT 1 - Al OFTION . RTD INPUT 1

ALAH.MZ HighMPR
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Configuration (Expanded Annunciator Option Config)

Analog Inputs (V&mA)

071618 12:10 071618 12:28

AMNALOG [MPUT 1 - Al OFTION AMALOG IMPUT 4 - Al OFTION

I P o B B e i B e e B e P i |
Gaz Flow RESET TAG MNAME: R ot

LUMIT: [CUFT TYPE:| 4-20rna FILTER: 4

hAIN: 1] Rfc:| 1000 TOTALS: Hour

NAME:

L' i] HIGH: i] ALARM: None

NAME - Sets the user-configured name for each input. The name may be up to 20 characters
long. Press RESET TAG to clear the name and reset input configuration (requires > 1s press).

Once a name is entered, the input is activated and the remaining configuration information will
appear. Note that Analog Input 4 is locked out since it is being reserved for use with the draft
control option.

UNIT - Sets the user-configured unit tag. The name may be up to 4 characters long.
TYPE — Select between 0-10V, 2-10V, 0-20mA or 4-20mA.

FILTER — Sets the filter time used to average the incoming signal. This is useful when the signal
is not steady (such as a draft sensor).

MIN, MAX — Sets the range of the input.

TOTALS - Sets the totalization for the input.
e None
e Minute: Totalization is calculated by the minute (i.e. gallons per minute).
e Hour: Totalization is calculated by the hour (i.e. gallons per hour).
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Configuration (Expanded Annunciator Option Config continued)

LOW, HIGH — Sets the alarm setpoints for the input. When the input is below the low setpoint
it generates a low alarm and when the input is above the high setpoint it generates a high
alarm.

ALARM - Select the alarms generated by the input. Manual reset alarms may be reset by
pressing RESET EA ALARMS on the ALARMS page.
e None
e Low Only: Only an auto reset low alarm is generated.
e LowMR: Only a manual reset low alarm is generated.
e High Only: Only an auto reset high alarm is generated.
¢ HighMR: Only a manual reset high alarm is generated.
e Low High: Both an auto reset low alarm and auto reset high alarm are generated.
e LowMR High: Both a manual reset low alarm and auto reset high alarm are generated.
e Low HighMR: Both an auto reset low alarm and manual reset high alarm are generated.
e LowMR HighMR: Both a manual reset low alarm and manual reset high alarm are
generated.
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Configuration (Expanded Annunciator Base Config continued)

Monitored Analog Outputs

The monitored analog outputs can be configured to take an action based upon the value in any
of the Modbus registers.

07/16415 12:31

ANALOG OUTPUT f MOMITORED WALLE 1
IF MODEUS ADORESS 12 i 1
LMY ACTUAL YALUE
Tl | M: 1] ful 20 150 TOTALS: MHone
L' ] HIGH: 1] ALAFR: MNane

IF MODBUS ADDRESS — Sets the Modbus register index to monitor and the divider to apply to
it. The name of the chosen address will then be displayed.

MIN, MAX — Sets the scale for the analog output. If the actual value falls outside of the scaled
range, the minimum or maximum value will be the output. For example, if address 12, 'LMV
ACTUAL VALUE' is being monitored with a range of 0-150 (psi) and the actual is 160PSI, the
output would be 100%. If it were 75PSI, the output would be 50%.

TOTALS, LOW, HIGH, ALARM - See the section Configuration (Expanded Annunciator Option
Config) - Analog Input (V & mA) for additional detail.
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Configuration (Expanded Annunciator Option Config continued)

Draft Control (V&mA)

07415415 EE
ORAFT SETUFR
SEMNSOR SEMSOR SEMSOR
-3.00" 300" o

MIN: MK - e

[t 2007 Rl 00" FILT ER: 2
hAIH: [ Ehe

PULSE E0lms FULSE Rlilms
OM: OFF:
e 300 FaT 1280 s ,5919 il
Tl H: ful 20 " CALIBRATE

TYPE — Select between 0-10V, 2-10V, 0-20mA or 4-20mA.

FILTER - Sets the filter time used to average the incoming signal. This is useful when the signal
is not steady.

SENSOR MIN, SENSOR MAX - Sets the range of the input. The minimum may be a negative
number.

DRIVE MIN, DRIVE MAX — Sets the limits of the damper in angular degrees.

PULSE ON, PULSE OFF - Sets the duration of the on and off damper drive pulses.

POT MIN, POT MAX — Sets the range of the feedback pot to scale from 0 to 90 degrees.

AUTO CALIBRATE - Activates the potentiometer calibration. This can only be performed when
the LMV is in phase 12 (idle). The damper is paced from open to closed and the potentiometer

readings are recorded. The potentiometer will automatically recalibrate each end position with
every cycle of the damper.
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Configuration (Expanded Annunciator Option Config continued)

Additional Draft Options

Assigning the name 'Draft Switch Auto' (case-sensitive) to any of the digital inputs will cause
that input to replace the virtual OPEN-AUTO switch (activation = AUTO). Use this option when
a hard-wired switch is preferred.

Assigning the name 'Draft Feedback' (case-sensitive) to Analog Input 3 will cause that input to
be used for draft damper feedback. Use this option when an analog feedback signal (instead of
resistive) is preferred. The feedback signal must represent 0-100% of the operating range.
Using this option will also release RTD 4 for general use (normally it is reserved for draft
damper feedback when draft control is optioned).
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Configuration (Expanded Annunciator Option Config continued)

RTD Inputs (RTD)

07/158/15 12:29 07/158/158 12:30
RTD INFUT 1 RTD INFLUT 4
e
MAME: [Head Temperatura HEE MAME: Feadback: ¢ oo cee
e e e P
TYPE:| PHOO0O
OFFSET:| 00
an:| 00 HIGH:| 1400 ALARM: [T Lnuu;| 00 HIGH:| 00 ALARM: Hone

NAME - Sets the user-configured name for each input. The name may be up to 20 characters
long. Press RESET TAG to clear the name and reset input configuration (requires > 1s press).

Once a name is entered, the input is activated and the remaining configuration information will
appear. Note that RTD Input 4 is locked out since it is being reserved for use with the draft
control option, although the low and high alarms can still be set if desired.

TYPE — Select between Pt1000, Pt100 or LG-Ni1000.

OFFSET - Sets the offset in degrees applied to the input. This may be used to compensate for
errors introduced by long wire runs.

LOW, HIGH, ALARM - See the section Configuration (Expanded Annunciator Option Config) =
Analog Input (V & mA) for additional detail.
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Configuration (Expanded Annunciator Option Config continued)

Economizer (RTD)

WATER IN, WATER OUT, STACK IN, STACK OUT (OFFSETS) — Sets the offset in degrees applied
to the input. This may be used to compensate for errors introduced by long wire runs.

TYPE - Select between Pt1000, Pt100 or LG-Ni1000.

USE LMV FOR STACK IN — Select whether the stack temperature in is from the LMV input
instead of the RTD input.

e No

e Yes
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Configuration (Expanded Annunciator Option Config continued)

Expanded Annunciator As Load Controller

If the selected load controller is 'LMV3x Only', the Expanded Annunciator may be configured to
operate as a load controller. To configure this option a process variable must be assigned to
one of the analog or RTD inputs.

Assigning a name containing 'E1' (case-sensitive) to any of the analog or RTD inputs will cause
that input to be assigned to E1 of the Expanded Annunciator load controller, which is the
process variable.

Assigning a name containing 'E3' (case-sensitive) to any of the analog or RTD inputs will cause
that input to be assigned to E3 of the Expanded Annunciator load controller, which is the alarm
variable.

Assigning a name containing both 'E1' and 'E3' (case-sensitive) to any of the analog or RTD
inputs will cause that input to be assigned to both E1 and E3 of the Expanded Annunciator load
controller simultaneously.

For further detail on using the Expanded Annunciator load controller, see the section Expanded
Annunciator - Load Controller.
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Configuration (Email)

Press EMAIL to configure email settings.

LOCAL SETPOIMT:

PROFORTIONAL:

INTEGRAL:

DERIVATIVE:

LMYS OF MODE:

The touchscreen can be configured to send email to up to six addresses. This requires that the
touchscreen is connected to a network with Internet access. The touchscreen comes
configured to use a specific outgoing mail server but this can be changed if necessary (see
Appendix - Email Options for additional detail). Emails are sent automatically when alarms occur
and may be sent manually to send screen captures and other data from the touchscreen.

SEND TEST EMAIL
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Configuration (Email continued)

To configure an email address, press the ON/OFF button to the left of the address line, then
enter the address.

H B ELED

SEND TEST EMAIL

A template is provided to allow text messages to be sent via email. Press the phone icon on the
right to bring up the template.

d A ELELE
Iy MY HY:0Y: 0y

SEND TEST EMAIL.

SEND TEST EMAIL |

To check that the email addresses are valid and were entered correctly, press SEND TEST
EMAIL.
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Configuration (Backup)

Press BACKUP to backup or restore settings to the USB drive.

0716418

LOCAL SETPOINT:
PROFPORTIONAL:
INTEGRAL:

DERIMATIVE:

I

10:68

S3P3l

10.1%

05/26./18 16:44

SYSTEM

SETTINGS

SAYE TD USE

RESTORE FROM USE

EMAIL SETTINGS

SAVYE TO USE

RESTORE FROM USE

EXPAHNDED AHNHU

HCIATOR SETTINGS

SAYETO USE

RESTORE FROM USE

LMWS OF MODE: || IntLR B

System settings, email settings or Expanded Annunciator settings can all be saved to the USB
drive for backup and migration to other units. The data is saved in an editable .csv or .txt
document and can be edited using a standard text editor or spreadsheet application. For the
desired group, press SAVE TO USB to save the current settings and press RESTORE FROM USB
to overwrite the current settings. If a backup file does not exist or invalid parameters are
found, an error message will be displayed.

gl

System Settings
System settings are the configuration options. This is the data found on the OPTIONS screen as
well as some additional system data such as color/shape and screen settings.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT\TSKSETUP.CSV, xx is 6 for 6", 10 for 10"

Email Settings
Email settings include the six configurable email addresses.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT\EMAIL.TXT, xx is 6 for 6", 10 for 10"

Expanded Annunciator Settings
Expanded Annunciator settings include all configuration data from the base and options.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT\EASETUP.CSV, xx is 6 for 6", 10 for 10"
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Boiler Overview
Access level: USER

The boiler overview screen displays the real-time data of the boiler. From the MAIN MENU
screen, press BOILER OVERVIEW. The BOILER OVERVIEW screen will appear.

07517715 ] 07/ 15/15 10:17

-E0- HORMAL OFERATION
53
1

STARTUPS: 1127
- HOURS:526

PV B2PSI
SP 99P5I
GAS

Efficiency 93 0%
Oxygen3 1%

Flue

.

Ambient
F1"F

¥SD 82.9% Output98.3%
!:Iame !DD.DBG

Shell 2b1°F

Only the parameters that are optioned and active are shown. Any others are hidden from the
display for clarity. Touching the area displaying the O, trim data will display additional data.
The following parameters may be shown on the overview screen:

Phase: The phase of the boiler is always displayed in a horizontal bar at the top of the screen.
PV: Displays the actual value of the boiler.

SP: Displays the current setpoint of the boiler.

Fuel In Use: Displays the current fuel being used (uses fuel tags).

Firing Rate: Displays the firing rate of the boiler from 0-100%.

Manual Active: Displayed in red text if the boiler is in manual mode.

Air, Fuel Actuators: Displays the position of the air and/or fuel actuator.

Aux Actuators: Displays the position of the auxiliary actuators if equipped (LMV5x only).

VSD Output: Displays the speed of the VSD from 0-100%.

Shell Temp: Displays the current boiler shell temperature.

Startups: Displays the number of boiler startups on the selected fuel.

Hours: Displays the number of hours run on the selected fuel.

Flue Temp: Displays the current flue gas temperature (LMV5x only).

Ambient: Displays the current ambient temperature (LMV5x only).

Efficiency: Displays the current combustion efficiency (LMV5x only).

0,: Displays the current O, percentage in the stack (LMV5x only).

Excess Air: Displays the current excess air percentage in the stack (LMV5x only).

CO,: Displays the current CO, percentage in the stack (LMV5x only).

Lead/Lag Status: Displays the current lead/lag status (when connected to Lead/Lag Master, see
section Remote Control for additional detail).
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Boiler Overview (continued)

Touching the boiler image will navigate to the REMOTE CONTROL screen (see Remote Control
section for additional detail).

07/16/16 10:17

-50- NORMAL OFERATION

Efficiency 93 .0%
Dxygen3. 1%

PV 52PSI 0
SP 99P5I !

GAS g STARTUPS:1127
- HOURS:526

Ambient
F1"F

U Output98.3%

Touching the graph will navigate to the CURVE DATA screen. Each fuel has a unique curve and
must be commissioned separately (see Curve Data section for additional detail).

07/16/16 10:17

-50- NORMAL OFERATION

PV 52PSI 0
SP 99P5I !
GAS

Efficiency 93 .0%
Dxygen3. 1%

STARTUPS:1127
- HOURS:526
F3I9"F

- Aux-3

¥5D 88.9% Output933% 147"

Flue

Ambient
F1"F

Shell 2b1°F

Touching the boiler stack will navigate to the DRAFT/ECONOMIZER screen. (see
Draft/Economizer section for additional detail).

07/16/15 10:17

-B0- MORMAL OFERATION

PY B2PSI L Efficiency 93.0%
SP 99P5I ! Dxwaen3 1%

GAS STARTUPS: 1127
- HOURS:526

—

U Output98.3%

Ambient
F1"F

Shell 251°F
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Boiler Overview (continued)

Touching the process data will navigate to the SETTINGS screen. (see Settings section for
additional detail).

07/18/18 10017

-50- NORMAL OFERATION

PV 52PSI 0
SP 99P5I :

Efficiency 93 .0%
Dxygen3. 1%

STARTUPS:1127
- HOURS:526&

-ﬂ

U Output98.3%

Flue
339"F
Aux-3
147"

Ambient
F1"F

Air o
i Shell 251°F

Fuel

Curve Data

Pressing the ACTION button for >1s displays the option menu.

IDD ATR — 1 :DD ATR 1

FU E L FUE L
330 VED [ | Z30lysp —

AT - | o |a
D:BD | EBD Minimum Load Maximum Load
ﬁ.;.-u ! & 7n 10% 100%
» | >
“ 60 | 260
gs0 ! Es0
E i ;. 340 | CREATE GRAPH |
.0 | COPY TO| [ EMAIL

g

= __ = |EHASE GHAPH| | L || ML
=20 ! 1220
310 3 Sof | [ eamcel || ear |
< o : < o

O 10 Z0 30 40 50 60 70 8030 100 010 20 30 40 50 B0 0 B0 90 100

FIRING RATE PERCENT FIRING RATE PERCENT

Minimum Load, Maximum Load — Sets the range of allowable modulation. These must be set
to unlock the CREATE GRAPH button.

CREATE GRAPH - Activates the graph creation function. This commands the LMV to run at
firing rates from the minimum to maximum incrementally and will record the data.
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Boiler Overview (continued)

:DD AIR — :DD AlR  —
FUE L FUE L mm
ZA0 WSO m— ZI0ly5SD m— ——
[y Ty Y
EBD Minimum Load Maximum Load EBD Minimum Load Maximum Load |
& 70 7o 10% 100%
2 ' 2
=50 GENERATING CURVE - 20%/5s =60 GRAPH COMPLETE - SUCCESS [~
Es0 Es0
aso]| CREATE GRAPH | as| | | CREATE GRAPH |
[=] [=]
30 - 10| [CEMAL 30 COPY TO| [ EMAIL
%% | |ERASE GRAPH | (ST 0| | AL z ERASE GRAPH | ["\,cp | | crapn
Ezu Ezu
Sof || camceL || mar | Siof [| cancer || ear |
E (1] o e v E (1] = s r——
0 10 20 30 40 50 60 70 80 90 100 D0 10 20 30 40 50 60 70 80 90 100
FIRING RATE PERCENT FIRING RATE PERCENT

While the curve is being generated, the progress is shown. If it takes longer than 60 seconds to
record any point (LMV shuts down for any reason), the function will be aborted with an error
and may be restarted at another time. When the function is complete, the LMV will return to
the state it was in when the function began, and the graph will display with an orange line
indicating the current position on the graph where the LMV is operating. Pressing ERASE
GRAPH will clear all stored graph data.

Press COPY TO USB to save the graph data to a .csv file. If email is configured, press EMAIL
GRAPH to send an email with the graph data .csv file attached. Note that a USB drive must be
inserted to send email since the attached file is first stored on the USB drive.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT, xx is 6 for 6", 10 for 10"
Filename = LMV_CURVE_DATA_mm_dd_yyyy.CSV, mmddyyyy are date
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TS Series

Boiler Overview (continued)

If the LMV is held at any even point on the graph (10%, 20%, 30%, etc.) the OVERWRITE POINT
button will appear. If pressed (requires > 2s press) the current data at that point will overwrite
the saved data. The 6" touchscreen kit will graph 10 points and the 10" touchscreen kit will

graph 20 points.

Forcing Screen Saver

100JAlR . :
= |FuEL OVERWRITE POINT

=
Ta0lysp

Za0

*1]
&7
=

w
:'BD

o 10 20 30 40 50 60 70 B0 90 100

FIRING RATE PERCENT =

Touching either of the top corners for > 1s will force the screen saver to display if configured
(See the section Configuration (Screen Settings) for additional detail).

e

SP 99P5I1
GAS

-E0- HORMAL OFERATION

-':_’l Efficien cy 93 0%
| L O=xygend 1%

STARTUPS: 1127
- HOURS5:5286

*

ALl  Output98.3%

Ambient Klue

F1"F
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Remote Control

Access level: USER

The HAND-OFF-AUTO mode of the boiler may be set at any time. From the MAIN MENU
screen, press REMOTE CONTROL. The REMOTE CONTROL screen will appear.

07 /16715 09:31

RERACTE COMNTROL
OFF
HAND C. AUTO
Ll T T, Q 1 MAHUAL RATE
2 P 20.0%

Local fRemote: Loeal
Watchdog Timer: 30s Elapsed Timer: 30s
Remote Mode: Fire Rate
Remote Setpoint: 93P5I
Remote Fire Bate: 20.0%

HAND-OFF-AUTO - Sets the mode of the boiler to manually on, manually off, or automatic. See
Table 2 or Appendix - Hand-Off-Auto Flowchart for additional detail.
e HAND: The boiler is commanded to run.
e OFF: The boiler is commanded to remain off.
e AUTO: The boiler is commanded to operate off of the remote commands (if present).
This is subject to the watchdog timer, which will revert to local if remote commands are
invalid or not present.

0717715

PROGRAM
STOP

/' Warning: If the LMVS5 is in firing rate control mode, an external automatic reset
temperature control must be present on the boiler since the internal load control
thermostat function is not active in this mode.
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TS Series

Remote Control (continued)

MANUAL ACTIVE/INACTIVE - Select manual forced operation when in HAND.

e INACTIVE
e ACTIVE

MANUAL RATE - Sets the firing rate when manual operation is enabled.

Table 2: LMV Actions in HAND/OFF/AUTO

Position Local/Remote | Remote Mode | Setpoint Used | Firing Rate Used

HAND (Manual Inactive) Local n/a W1/W2 Internal LC
HAND (Manual Active) Remote Burner On w3 Remote
OFF Remote Burner Off w3 n/a

AUTO (Mode Auto) Remote Automatic w3 Internal LC
AUTO (Mode On) Remote Burner On W3 Remote
AUTO (Mode Off) Remote Burner Off w3 n/a

AUTO (Watchdog Expired) Local n/a W1/W2 Internal LC

Pressing the PROGRAM STOP button displays the program stop menu.

Hmm['.

b

Local fHemote:
Watchdog Tim)

Remote Mode:

Remote Setpoi
Remote Fire R3

07165158 09:40
CURRENT
Deactivated == :
CHANGE TO INACTIVE
Phase 24 hNUAL RATE
Prepurge 20.0%
APPLY (=15)
0=
PROGRAM
EXIT sTOP

After the new program stop is selected, hold APPLY for > 1s to save change. Press EXIT when

finished.
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Remote Control (continued)

If connected to a Lead/Lag Master, the status of the boiler will be displayed as well.

077164156 05:30

.

ARG T 1 L S

e e e R e L

[ et ey

LocalfRemote: Remote
Watchdog Timer: 30s
Remote Mode: Fire Rate
Remote Setpoint: 100PSI
Remote Fire Rate: 0.0%

Elapsed Timer: 75

PROGRAM
STOP

All of the possible status messages are displayed in Table 3.

Table 3: Lead/Lag Status Messages

Message

Definition

LEAD/LAGx BOILER

The current boiler designation.

LEAD/LAGx BOILER -

The current boiler designation, also indicates that warm standby is active due

WSB ACTIVE ON TEMP to temperature.
LEAD/LAGx BOILER - The current boiler designation, also indicates that warm standby is active due
WSB MIN RUN to unsatisfied minimum run timer after temperature satisfied.

FORMER LEAD -
CHANGEOVER IN PROGRESS

The boiler is transitioning from a lead boiler to a lag boiler.

BOILER NOT AVAILABLE

The boiler is not available due to one of the following reasons (boiler control
switch is off, boiler is not in automatic mode, boiler is in lockout, or boiler with
LMV5x controller is not set for IntLC Bus or ExtLC Bus). Touching the status
message (shown below) will display the current status of these qualifiers.

OVERRIDE MODE

control.

The override input on the lead/lag master is activated and is the source of

07/16415B 05:45

§ H-0-A SWITCH IN AUTO:
LMY NOT IN LOCKOUT:

LMV OPERATING LIMIT:

|

Locald LMVS BUS CONTROL MODE: {'31,
Watch
Remot
Remote Setpoint: 39F5]
Remote Fire Rate: 20.0%

_BDILEH HOT AVAILABLE

oA M

STOP
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Alarms

Access level: USER

Alarms are displayed on a dedicated alarm screen. The last 250 alarms are stored in memory
and time stamped. When an alarm is present, a link to the alarm screen will flash over the title

bar of the OVERVIEW screen. Otherwise, this screen may be accessed from the main menu.

To access the alarm screen from the main menu, press ALARMS. The ALARMS screen will
appear.

RERACTE CO

Cleared

P FWFEE FEEDWWATER CORM FALILT

SETTIMNGS

COPY TO USB

The ALARMS screen lists current alarms as well as older alarms. The color of the alarm
indicates the category of the alarm.

Red — LMV lockouts. The text flashes when the alarm is currently active.

Orange — LMV faults.

Yellow/Green — Communication faults. The background is yellow when the alarm is currently
active and green when communication is present.

Blue — All other alarms such as analog alarms, pump alarms, and expanded annunciator alarms.
The text flashes when the alarm is currently active.

Information about the most recent 250 alarms will be displayed with the following information:

No. — Number of the alarm in the list (1 is most recent).
Date — Displays the date that the alarm occurred.

Active — Displays the time when the alarm became active.
Cleared — Displays the time when the alarm was cleared.
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Alarms (continued)

The icons at the top of the screen may be used to navigate through the list of alarms:

=1

Move up one alarm on list.
Move down one alarm on list.
Navigate up one page on list.

Navigate down one page on list.

From the ALARMS screen, press LOCKOUTS to access the lockout history (only appears for
LMV5x controllers) or press FAULTS to access the fault history. The 9 most recent lockouts are
displayed and the 21 (LMV5x) or 25 (LMV3x) most recent faults are displayed with index 0 as
the most recent and the number ascending as they get older.

Mo [oste [ Actve [ Cloarsa | No. [Dste [ Actve [Cleara |

" RuvFEE FEEDWVATER COMM FALILT b' RWWEEE FEEDWVATER COMM FALILT

COPYTOUSB | | _ COPY TO USB

SCCInc.
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Alarms (continued)

Press the left and right arrows at the bottom of the screen to toggle between lockouts/faults.

[o7/16/15 " cockour o TN 14.06 o7/16/15 ] FAULT O [N 1407 ]
Lockout Code: 21 Error Code: 21
SAFETY LOOP OPEN SAFETY LOOP OPEN
Diagnostic Code: 00, Error Class: 0 Diagnostic Code: 00, Error Class: 0
Phasze: 60 NORMAL OPERATION Phasze: 60 NORMAL OPERATION
Timestamp: 7516515 10:31:19
Fuel: GAS, Qutput: 66% Fuel: GAS, Qutput: 66%
Startup Counter: 1132 Startup Counter: 1132
Hours Counter: 532

= [corvTouss | = = [covTo Uss | =

The following information is displayed on the screen for each lockout:

LOCKOUT/FAULT CODE - Displays the LMV lockout or fault code.

DESCRIPTION - Lists a description of the lockout or fault in red text.

DIAGNOSTIC CODE - Displays the LMV diagnostic code.

ERROR CLASS - Not used.

ERROR PHASE - Displays what phase the LMV was in when the lockout or fault occurred.
TIMESTAMP - Displays the date and time when the lockout occurred (lockouts only).
FUEL - Displays the fuel being used when the lockout or fault occurred.

OUTPUT - Displays the firing rate when the lockout or fault occurred.

STARTUP COUNTER - Displays the start number when the lockout or fault occurred.
HOURS COUNTER - Displays the total number of hours run when the lockout occurred
(lockouts only).
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Alarms (continued)

Press COPY TO USB to save the complete lockout or fault history to a .csv file. If email is
configured, press EMAIL HISTORY to send an email with the lockout or fault history .csv file
attached. Note that a USB drive must be inserted to send email since the attached file is first
stored on the USB drive.

On the USB drive, data can be found at:

Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT, xx is 6 for 6", 10 for 10"

Filename (lockouts) = LMV_LOCKOUT_HISTORY_mm_dd_yyyy.CSV, mmddyyyy are date
Filename (faults) = LMV_FAULT_HISTORY_mm_dd_yyyy.CSV, mmddyyyy are date

07/16/15 14:08

Lockout Code: 21

SAFETY LOOP OPENH

Diagnostic Code: 00, Error Class: 0
Phage: 60 NORMAL OPERATION
Timestamp: 716515 10:31:19
Fuel: GAS, Qutput: 66%

Startup Counter: 1132

Hours Counter: 532

EMAIL HISTORY
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Alarms (continued)

From the ALARMS screen, press the RESET EA ALARMS button to clear expanded annunciator
alarms designated as manual reset or latched. This button has no effect on LMV alarms.

No__[Date | Active _[Cloared [

b‘ RUWFSE FEEDWATER COMM FRLULT

COPY TO USB

Press COPY TO USB to save the complete lockout or error history to a .csv file. If email is
configured, press EMAIL to send an email with the lockout or error history .csv file attached.
Note that a USB drive must be inserted to send email since the attached file is first stored on
the USB drive.

The resulting CSV file is in a tab-separated format and can be viewed with any text editor or
spreadsheet application. On the USB drive, data can be found at:

Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT, xx is 6 for 6", 10 for 10"

Filename = ALARMS_mm_dd_yyyy.CSV, mmddyyyy are date

No. [Date [actve ciowed | | [No. [Date | Actve ciewea 0]

r FuFEE FEEDWWATER COMM FALILT P FWFEE FEEDWWATER CORM FALILT

[_corrtouss || emar_| COPY T0 UsB

NOTE: If a boiler circulating pump is optioned with the Expanded Annunciator, an alarm is
generated when feedback is not received within 20 seconds of the pump being commanded on.
If this alarm appears, it must be reset using the RESET EA ALARMS button. The alarm will also
automatically clear if pump feedback is received while an alarm is present.
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Input and Outputs
Access level: USER

The status of the LMV inputs and outputs may be viewed at any time. From the MAIN MENU
screen, press IN/OUT DETAIL. The INPUT DETAIL screen will appear.

FufF 01 INPUT

FufF 02 INPUT
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Input and Outputs (continued)
All inputs that are currently energized will display as ON with a bright green background. All

inputs that are currently de-energized will display as OFF with a dull green background. To view
the OUTPUT DETAIL screen, press OUTPUTS. The OUTPUT DETAIL screen will appear.

07/16/156 07/16/16
ALARM |_

When the LMV controller is in alarm, the ALARM output will flash bright red. When the
controller is not in alarm, the alarm output will be a dull red background. All other outputs that
are currently energized will display as ON with a bright green background. All other outputs
that are currently de-energized will display as OFF with a dull green background.
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Fuel Statistics
Access level: USER

Both the LMV3x and LMV5x controllers keep track of certain fuel statistics. From the MAIN
MENU screen, press FUEL STATISTICS. The FUEL STATISTICS screen will appear.

07416418 18:08
rair oUTPUT Gas JIRRES
[100.0m

RN = s A Re | | 72 HOLIRS
STARTUPS G [ 73 5TARTUPS
=Y [ 249145 CUBICFT
[100.0m
[40HoURS

s =Re W | 40 STARTUPS
TOTALIZED 0L NGRS

(REREND] IERE usB__ |

MIN OUTPUT GAS/OIL — Displays the minimum allowable load output programmed in the LMV
controller.

MAX OUTPUT GAS/OIL - Displays the maximum allowable load output programmed in the LMV
controller.

HOURS RUN GAS/OIL — Displays the hours that the LMV controller has run on gas or oil.
STARTUPS GAS/OIL — Displays the number of startups that the LMV controller has had on gas
or oil.

TOTALIZED GAS/OIL — Displays the totalized volume of gas (in cubic feet) or oil (in gallons) that
has been used.

CURRENT FLOW - Displays the current flow rate of gas or oil.

|
|
|
|
|
[o.0m4 |
|
|
|
|
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Fuel Statistics (continued)

Press USB to save a summary of the fuel statistics to a .txt text file. If email is configured, press
EMAIL to send an email with the summary .txt text file attached. Note that a USB drive must be
inserted to send email since the attached file is first stored on the USB drive.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT, xx is 6 for 6", 10 for 10"
Filename = LMV_FUEL_STATS_mm_dd_yyyy.TXT

07421418 16:00
N [0.0% |
[ 100.0% |
[ 83 HOURS |
[ 78 STARTUFPS |
[ 237838 CLBIC FT |
|
|
|
|

[0.0%

[ 100004
[40HOURS

[ 40 STARTUFS

) 3 5169 GALLOMS
CLIRREMT EMAIL
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LMV Controller Data
Access level: USER

The static details of the LMV controller may be viewed at any time. From the main menu, press
LMV DATA. The software revision for the touchscreen is shown on this screen.

07417415 0737

Lhfif OL TYFE [A5M] LMEZ 24081
20
B0
5707
15
410
130
SSiIhd
171 52 40E 1
1
B10
B0

N [
0L 1D DATE 12/2/13

T5-Gxx5-KT Rev. 15F1 | usB

LMV CONTROL TYPE (ASN) — Displays the model number of the LMV controller.

LMV PARAMETER SET CODE - Displays the parameter set code of the LMV controller.

LMV PARAMETER SET VERSION - Displays the parameter set version of the LMV controller.
LMV CONTROL ID DATE - Displays the date of manufacture of the LMV controller (MM/DD/YY).
LMV CONTROL ID NUMBER - Displays the unit ID number of the LMV controller.

LMV BURNER SOFTWARE VERSION - Displays the software version of the LMV controller.

LMV LOAD CONTROL SW VERSION - Displays the load controller software version (LMV5x only).
LMV IDENTIFICATION - Displays the burner ID of the LMV controller.

AZL5 CONTROL TYPE (ASN) — Displays the model number of the AZL display (LMV5x only).

AZL5 PARAMETER SET CODE — Displays the parameter set code of the AZL display (LMV5x only).
AZL5 PARAMETER SET VERSION - Displays the parameter set version of the AZL display (LMV5x
only).

AZL5 SOFTWARE VERSION — Displays the software version of the AZL display (LMV5x only).
AZL5 IDENTIFICATION NUMBER — Displays the unit ID number for the AZL display (LMV5x only).
AZL5 CONTROL ID DATE — Displays the date of manufacture of the AZL display (MM/DD/YY)
(LMV5x only).
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LMV Controller Data (continued)

Press USB to save a summary of the LMV controller data to a .txt text file. If email is
configured, press EMAIL to send an email with the summary .txt text file attached. Note that a
USB drive must be inserted to send email since the attached file is first stored on the USB drive.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT\LMV_ID_DATA.TXT, xx is 6 for 6", 10 for 10"

16:01

LAV 240E 1
20
A00
5I707
15
40
190
ShS Thd
A 52 A0B1
1
510
&00
i 3
825 COMTROL 10 DATE 1242013

_ T5-B35-KT Rew. 15F1 EMAIL

Page 54 SCCInc.



TS Series Installation Instructions
Document No. TS-1100

Draft / Economizer
Access level: USER / TECH / SETUP

If the draft control or economizer option are configured with the Expanded Annunciator, press
DRAFT ECONOMIZER to access these detail screens. If only one of the two are optioned, the
button will link directly to the optioned screen. This screen can be accessed from the USER
level, but settings may only be changed from the TECH or SETUP levels.

0717715 07:44 0717715 09:17
Stack Outlet 301 3"F
Dutleat
Water
176.0"F
Inlet 'DRAFT
Water CONTROL
139.87F SWITCH
SETTIMGS Stack Inlet 356 _1"F
Fosition
107 Gl 5

If both are optioned, touch the draft damper to access the DRAFT DETAIL screen or touch the
economizer to access the ECONOMIZER DETAIL screen. See the specific sections for additional
detail on the information shown.

07717715 0917

Stack Dutlet 301 _9"F

Inlet DRAFT
Water CONTROL
139.8"F SWITCH

SCCInc. Page 55



Installation Instructions TS Series
Document No. TS-1100

Draft / Economizer (continued)

Draft Control

07417418 09:51 07417418 09:55
= SETP.;,,NT: DR A SETPDINT:
OPEN P e e

CLOSED P CONTROL CONTROL
IGNITION PROVEN SWITCH SWITCH

ED“"A"D I.s. S-:.*IITEH DPEH FhSiTlu" _ RESET.
Draft

Position “ o012 Position
47.8" ®_|—| 47.8"

[
Ceeevons] [ &

DRAFT ALARM - A draft alarm is currently active.

OPEN PROVEN - The draft damper has proven the open position switch.

CLOSED PROVEN - The draft damper has proven the closed position switch.

IGNITION PROVEN - The draft damper has proven the ignition position switch.

SETPOINT - Sets the desired draft setpoint (TECH or SETUP required).

DRAFT CONTROL SWITCH - Displays the draft control Open/Auto switch (see Draft Control
Switch section for additional detail).

CURRENT STATUS - Displays the current status or alarm message (see Draft Control Sequence /
Messages section for additional detail).

RESET ALARM - Draft alarms must be manually reset using this button.

POSITION — Displays the current position in angular degrees.

DRAFT - Displays the current draft reading.

SO

Pressing DRAFT CONTROL SWITCH from either the DRAFT/ECONOMIZER or DRAFT DETAIL
screen to access the draft control switch (see Draft Control Switch section for additional detail).

077518 0917 077518 0555
Stack Dutlet 301 .9°F R -
2 Rl SETPDINT:m
o SERETAUAA, EE
Water - DRAFT
176.0"F CONTROL
SWITCH
RESET
Inlet g DRAFT ALARM
Water L= CONTROL
139.8"F SWITCH
Stack Inlet 356.1"F Position

Draft 47 8"
Position -0.30"
497" " ©
— a%

@ 5
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Draft / Economizer (continued)

Draft Control Switch

07 17715 09:18 07 17715 05:52

DRAFT CONTROL DRAFT CONTROL j

DPEN(QurtUTD DPEN(QurtUTD

EXIT EXIT

L
%

OPEN - Commands the draft damper open.

AUTO - Allows the draft damper to be controlled automatically to maintain the setpoint.

MANUAL ACTIVE/INACTIVE - Select manual forced operation when in AUTO.
e INACTIVE — Auto commands will come from the automatic setpoint control.
e ACTIVE — Auto commands will come from the open and close buttons.

OPEN (MANUAL ACTIVE) - Commands the draft damper open while this button is touched.
CLOSE (MANUAL ACTIVE) — Commands the draft damper closed while this button is touched.

Draft Control LMV5 Notes

Parameters must be set to allow the draft damper to have enough time to reach the required
positions. The time required for the damper to travel from closed to open is required to be
known. The prepurge and postpurge positions of the air actuator must also be set to match or
exceed the open position of the draft damper.

Set up the required parameters through the AZL (OEM password required):
1. Params & Display > RatioControl > Times > OperationRampMod > (damper travel) + 10s
2. Params & Display > RatioControl > Times > TimeNoFlame > (damper travel) + 10s
3. Params & Display > RatioControl > Gas/Qil Settings > SpecialPositions >
(Pre/Post)purgePos > (Pre/Post)purgePosAir > (damper open position) or further open
4. Params & Display > RatioControl > Gas/Qil Settings > SpecialPositions > HomePos >
HomePosAir > (damper closed position) or further closed
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Draft / Economizer (continued)

Draft Control Sequence / Messages

If the draft control switch is in OPEN, the command to the draft damper will be a constant
open. If the draft control switch is in AUTO, the command to the draft damper will follow the
sequence of operation as shown in Table 4.

Table 4: Draft Control Sequence of Operation (Switch in AUTO)

Phase Command Note
Draft Alarm Open Requires manual reset.
0,1,2 Open Lockout/safety state.
10,12 Close Idle state.
20to 34 Open Will alarm if open not proven before phase 30. (Alarm code 1)
36 Ignition Will alarm if ignition not proven before phase 38. (Alarm code 2)
38to 54 Ignition Stays in ignition position.
60, 62 Modulate Automatic open and close pulses to maintain the setpoint.
70to 83 Open Will alarm if open not proven before phase 74. (Alarm code 3)

The possible status messages are shown in Table 5.

Table 5: Draft Control Status Messages

Message Definition
COMMAND IS MANUAL POSITION The draft damper is being commanded manually open and closed.
COMMAND IS IDLE STATE There is no command to the draft damper (stays as is).
COMMAND IS DRIVE TO OPEN The draft damper is being commanded to open.
COMMAND IS SWITCH OPEN POSITION The draft damper is being commanded to open by external input.
COMMAND IS DRIVE TO CLOSED The draft damper is being commanded to close.
COMMAND IS DRIVE TO IGNITION The draft damper is being commanded to the ignition position.
COMMAND IS MODULATING OPERATION The draft damper is in modulation mode (open/close pulses).

The possible alarm messages are shown in Table 6.

Table 6: Draft Control Alarm Messages

Message Code Definition
NOT OPEN BY PHASE 30 1 Open position has not been proven by phase 30 (prepurge).
NOT TO IGN. BY PHASE 38 2 Ignition position has not been proven by phase 38 (preignition).
NOT OPEN BY PHASE 74 3 Open position has not been proven by phase 74 (postpurge).
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Draft / Economizer (continued)

Economizer

07/17515 09:15

Stack Dutlet 301 89°F

Outlet
Water
176.0"F

Inlet
Water
139.8"F

Stack Inlet — The stack temperature as it enters the economizer.
Stack Outlet — The stack temperature as it leaves the economizer.
Inlet Water — The water temperature as it enters the economizer.
Outlet Water — The water temperature as it leaves the economizer.
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Expanded Annunciator

Access level: USER / TECH / SETUP

If the Expanded Annunciator is optioned, press EXPANDED ANNUN. to access the detail screen.
The software revision for the Expanded Annunciator is show on this screen.

FEEDWWATER

ALOG IMPUTS SETTINGS Damper Ign. Pos.

EL SW Rew. 15F1

If extra RWF55 controls are optioned, press EXTRA RWF to access that screen. Press EXP.
ANNUN. to return to the EXPANDED ANNUNCIATOR screen.

Damper Ign. Pos.

EL 5 Rew. 15F1
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Expanded Annunciator (continued)

Load Controller

If the load controller is optioned, press LOAD CONTROL to access that screen. Press PREVIOUS
to return to the EXPANDED ANNUNCIATOR screen.

071718 12:4H1 07/20/18 05:30

SETPOINT:

Operating Contra

Py (E1): 174.0 INTEGRAL: 20s
- OUTPUT () - DERIWATIVE: Os
S T P

THEMOSTAT (K1) SWITCH QM (HYS1):

ALARM (KE) SWITCH OFF (HYS3): 5.0

CONFIG M¥1 FOR | | CONFIG M¥3 FOR | | CONFIG M¥4 FOR
Y (ANALDG) K1 {DIGITAL) KE {DIGITAL)

The operation of the Expanded Annunciator load controller is modeled after the operation of
the RWF load controller. Similar nomenclature is used for the inputs and outputs.

1800 FROPORTIOMAL:

Damper Ign. Pos.

EL S Rew. 15F1

SETPOINT - Sets the desired setpoint (TECH required).

PV (E1) — Displays the current value of E1 (process variable).

OUTPUT (Y) — Displays the current output.

E3 - Displays the current value of E3 (alarm variable).

PROPORTIONAL - Sets the proportional band for PID control (TECH required). The proportional
portion of the control output is generated by the actual value relative to the setpoint less the
proportional band. A smaller proportional band has a larger impact upon the process. For
example, if the actual value is 95, the setpoint is 100 and the proportional band is 20, the
control output will be 25% of the PID scale (setpoint minus actual, divided by the proportional
band). The control output will modulate whenever the actual value is within the effective
proportional band (80 to 100 in example). If the actual value is above or below the
proportional band limits the control output will be the PID maximum or PID minimum. Setting
the proportional band to 0 effectively disables the PID control.

INTEGRAL — Sets the integral time for PID control (TECH required). The integral portion of the
control output makes continuous adjustments based upon the error between the setpoint and
the actual value. A shorter integral time has a larger impact upon the process. For example, if
the output using the proportional band alone is 25% and the integral time is set to 15s, the
control output will double to 50% in 15s if the control variables remain constant. This 'integral
windup' will continue until the control output reaches the PID maximum or PID minimum.
Setting the integral time to O disables the integral portion.

SCCInc. Page 61



Installation Instructions TS Series
Document No. TS-1100

Expanded Annunciator (continued)

DERIVATIVE - Sets the derivative time for PID control (TECH required). The derivative portion
of the control output makes periodic adjustments based upon the rate of change in the actual
value. A larger derivative time has a larger impact upon the process. For example, if the output
using the proportional band alone is 25%, the derivative time is set to 10s and the actual value
decreases by 2, the control output will increase by 20% (10 x 2) in anticipation of how much the
current rate of change would affect the process 10s into the future. Setting the derivative time
to 0 disables the derivative portion. Derivative should be used with caution as it can create an
unstable control loop. When used, it is recommended that derivative time not exceed 25% of
the integral time.

ALARM (K6) — Sets the desired alarm setpoint. When the alarm output (K6) is active, the
output signal will be automatically restricted to the minimum. This is the automatic low-fire
hold function. (TECH required).

SWITCH ON (HYS1) — Sets the switch-on setpoint. The output will switch on when the PV <
SETPOINT + HYS1. This may be a negative or positive value. (TECH required).

SWITCH OFF (HYS3) — Sets the switch-off setpoint. The output will switch on when the PV >
SETPOINT + HYS3. This may be a negative or positive value. (TECH required).

PID MIN, PID MAX — Sets the desired output limits from 0% to 100%. (TECH required).
STATUS INDICATORS — Displays the status of the thermostat (K1) output or alarm (K6) output.
CONFIG MV1 FOR Y (ANALOG) — Configures Monitored Analog Output 1 to transmit the load
controller output. Use this option when a hard-wired analog output from the load controller is
desired (see the section Configuration (Expanded Annunciator Option Config) > Expanded
Annunciator as Load Controller) for additional detail).

CONFIG MV3 FOR K1 (DIGITAL) — Configures Monitored Digital Output 3 to transmit the load
controller thermostat output. Use this option when a hard-wired digital enable from the load
controller is desired (see the section Configuration (Expanded Annunciator Option Config) =
Expanded Annunciator as Load Controller) for additional detail).

CONFIG MV4 FOR K6 (DIGITAL) — Configures Monitored Digital Output 4 to transmit the load
controller alarm output. Use this option when a hard-wired digital alarm from the load
controller is desired (see the section Configuration (Expanded Annunciator Option Config) >
Expanded Annunciator as Load Controller) for additional detail).
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Feedwater

Access level: USER / TECH / SETUP

If the feedwater option is configured, press FEEDWATER to access the detail screen. This
screen can be accessed from the USER level, but settings may only be changed from the TECH

or SETUP levels.

0717715 174 0717715 a9

0%

FEEDWIATER

SETTIMNGS

The vessel will animate to show the level of fill based upon the scaling of the input in the RWF.
The setpoint (in percent of fill) will appear as a red line. The actual fill percent will appear at
the differential pressure transmitter graphic. Touching the setpoint on the RWF (green display)
will allow the feedwater setpoint to be changed (TECH required).

07717715 i

20%

AT -

| 1 { |

L E

TRy P

| § |

\BCH Ay
AT

Note that the RWF must be configured as specified in document RWF... Modulating Feedwater
Control Valve Application Guide for the graphical tank level to function correctly.
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Boiler Circulating Pump
Access level: USER / TECH / SETUP

If the boiler pump (hydronic systems only) option is configured with the Expanded Annunciator,
press BOILER PUMP to access the detail screen. This screen can be accessed from the USER
level, but settings may only be changed from the TECH or SETUP levels.

07717718 13:32 0771718 1464

COMMAND fu'II:IDE:| CYCLE WITH BOILER |

Ly DA TA

STﬁTUS:| IOLE |

BOILER
FLInF COMMAND: |-

SETTIMGS UTRUT: | Narmal |

COMMAND MODE - Selects the command mode is the method of pump control used. Setting
may only be changed at the SETUP access level.

e CYCLE WITH BOILER: The pump will be commanded on when the boiler is commanded
on. The pump will remain on after the boiler command is removed for the duration of the
off delay period.

e CONTINUOUS RUN: The pump will be commanded on as long as the HAND-OFF-AUTO
switch is not in OFF on the REMOTE OPERATION screen.

OFF DELAY - Sets the amount of time that the pump stays on after the boiler turns off when
the pump is set to mode 'CYCLE WITH BOILER'. Setting may be changed at TECH access level.

STATUS — Displays the status of the pump is displayed.
e RUNNING: The pump is currently on.
e IDLE: The pump is currently off because it is commanded to be off.
e ALARM: The pump is currently off because it is in alarm.

COMMAND - Displays whether or not the pump is currently being commanded on.
e ENABLED: The pump is being commanded on.
e DISABLED: The pump is being commanded off.

OUTPUT - Displays the logic of the pump output.
e NORMAL: The pump is output is normally open.
e REVERSE: The pump is output is normally closed.
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Boiler Circulating Pump (continued)

If the boiler pump is commanded on and operation is not proven within 30 seconds, a timed
pump alarm will occur. To reset this, press RESET ALARM on the BOILER PUMP screen, or the
pump will automatically reset once operation is proven.

071718 1464

COMMAND MDDE:| CYCLE W'ITH EOQILER |

sraruc
COMMAND: [ g =¥
ouTeuT:f Narral |
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TS Series

VSD

Access level: USER / TECH / SETUP

If the VSD option is configured, press VSD to access the detail screen. This screen can be
accessed from the USER level, but settings may only be changed from the TECH or SETUP levels.

07/17/15

TREMDS

BT TR
Feference: 80.00%, 48 0H=
Output: B80.00%, 48 0H=z

RFM: 2773

Output Current: 4 6B1A

Output Current Peak: iﬁéﬁ
Output Waoltage: 227 0¥
OC Bus Woltage: IFIY
OC Bus Waoltage Peak:

[
Output Povwer: 0.1 0kW

Fault Message: Mo Fault

Alarm Message: Mo Alarm

10L
W50 RUM

Total: M{Wﬁh

The peak output current and DC bus voltages are recorded during operation. To reset the peak

readings, press the values for > 1s (TECH required).
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VSD (continued)

Touch VSD SETUP to access the VSD SETUP screen.

Feference:  80.00%. 48 0H=z
Output: 80.00%, 48 0H=z
RFM: 2773

Output Current:  4.61A

071718 16:26

Output Current Peak: 461A

Dutput¥olage:  227.08 -
DC Bus Woltage:  371¥ 2REED EREES

DC Bus Waoltage Peak: cra by

Output Povwer: o_10kw Total: ﬁ.D'Hc'u'u'H
Fault Message: Mo Fault

Alarm Meszage: Ho Alarm

Model: | w1000

071718 i Ea

READ
PARAMETERS

WRITE
PARAMETERS

RFarnp Up: 258z
Farnp Dowen: 2 6=
Input Waltage: 480
Motor Current: | E.23A

FFM f Motor Poles:

Output k' 1.1 0k

Braking Resistor: Yes

1750 1 4

Model - Selects the model of VSD used (SETUP required).

e V1000
e A1000

Ramp Up/Down — Sets the ramp up or down time in the VSD (SETUP required).

Input Voltage — Sets the input voltage as per the motor nameplate (SETUP required).

Motor Current — Sets the current as per the motor nameplate (SETUP required). Touching this
brings up a template to calculate current with service factor. Touch APPLY to calculate and

enter the motor current.

07417418 18:31
Hameplate Current
Model: oo ,m BEAD
Famp Up: Service Factor BMETERS
1.18
Fa D : .
me oo i WRITE
Motor Current
Input Woltage: 7.82A E\_METERS
Motor Current:
RPM S Motor Pl APPLY
Output ki r_
Braking Resistor: EXIT

SCC Inc.
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VSD (continued)

RPM / Motor Poles — Selects the RPM and poles as per the motor nameplate (SETUP required).
e 1750/4
e 3500/2

Braking Resistor — Selects whether a braking resistor is connected to the VSD (SETUP required).
e No
e Yes

Touching READ PARAMETERS will read the current motor information as stored in the VSD.
Touching WRITE PARAMETERS (SETUP required) will write the supplied motor information as
well as the required LMV-specific parameters to the VSD. The screen will display 'WRITING TO
VSD...' while the parameters are being written.
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Analog Inputs

Access level: USER

If the analog or RTD options are configured with the Expanded Annunciator, press ANALOG
INPUTS to access the detail screen.

07/17/156 45 20 07/20/15 1053

Gas Flow | 25000 CFH  TOT:| 20834

RERACTE COMTROL

Stearn Flow | 50000 FFPH  TOT:[ 51866

RE D 08 Pressure IE,GUD{ Psl

FW Fressure | 100,00 F5I

MONITORED WALUE 1 TOTAL: [ 103383

If totalization is enabled for any of the analog inputs, touching the totalized value > 1s will reset
the value to O (TECH required). Toggle between analog and RTD inputs with the RTD and
V&mA buttons on the lower right.

Gas Flow | 25000 cPH  TOT:[ 20834 Iniat Water Temp | SSR
@00 CF

Steamn Flow SDDBQ: PPH  ToT:|  B16BE DA Temperature |

—
—

zoo0 P3l Dutside Temperature E2.0  °F

OA Pressure
FU Pressure | 100,00 PSI Ambient Temperature (7200 °F

MONITORED WALUE 1 TOTAL:| 103333
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TS Series

Settings

Access level: USER / TECH / SETUP

To access load controller settings (LMV, RWF, or EA internal), press SETTINGS to access the

detail screen.

Depending upon the load controller, different input options will appear.

07/20/15 08:21 07/20/15

LOCAL SETPOINT: 1280°F

FROFORTIONAL: 10.1%

INTEGRAL:

DERIMATIVE:

LifiS 0F MODE: || IntlR Bus

07417715 1= 30

BOILER
FLNF

SETTINGS

LG I

LOCAL SETPOINT:|  180.0°F
FROPORTIONAL:
INTEGRAL:| 1200=
DERNATIVE:
ALARM (KE:
SWATCH TN (HYS;

SWITCH OFF (HYS2):

Sl

LOCAL SETPOINT - Sets the desired setpoint (TECH required). This parameter may be limited
by Ext MinSetpoint and Ext MaxSetpoint on an LMV5x controller.

PROPORTIONAL - Sets the proportional band of the load controller (TECH required). A

proportional band of 10 means that the firing rate of the boiler will be 100% when the actual
value is 10 below the setpoint. On the LMV5x, the proportional band is a percentage of 14.5
PSI (for steam boilers) or 212°F (for hydronic boilers). On an RWF10, RWF40, or RWF55 load
controller, the proportional band is an absolute number.
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Settings (continued)

INTEGRAL - Sets the time of the integral component of the load controller (TECH required).
The integral component corrects for steady state error between the setpoint and actual value.
Shorter times are more aggressive. A setting of zero eliminates the integral component.

DERIVATIVE - Sets the time of the derivative component of the load controller (TECH required).
The derivative component corrects for the rate of increase/decrease of the actual value.

Longer times are more aggressive. A setting of zero eliminates the derivative component and
typically works well on boilers.

ALARM (K6) — Sets the desired alarm setpoint (TECH required).

SWITCH ON (HYS1) — Sets the burner on setpoint for RWF load controllers (TECH required).
e RWF40/RWF55: Sets the burner on threshold additive with the setpoint. For example,
a value of -5 means the burner will turn on when the actual value is 5 below setpoint.
e RWF10: Sets the burner on threshold subtractive with the setpoint. For example, a
value of 5 means the burner will turn on when the actual value is 5 below setpoint.

SWITCH OFF (HYS3) — Sets the burner off setpoint for RWF load controllers (TECH required).

e RWF40/RWF55: Sets the burner off threshold additive with the setpoint. For example,
a value of 5 means the burner will turn on when the actual value is 5 above setpoint.

e RWHF10: This setting behaves differently for steam and hydronic boilers. For steam
boilers, the span of the pressure transducer affects this setting. For example, if the span
of the pressure transducer is 0-60 PSI, a value of 10 for ALH1 means the burner will turn
off when the actual value is 6 (60*10%) above the burner on point. For hydronic boilers,
a value of 10 means the burner will turn off when the actual value is 10 above the
burner on point.

LMV5 OP MODE - Displays the LMV5x load controller operating mode (LMV5x only).
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Datalog / Trends

Access level: USER / TECH / SETUP

Four trends available that can record two variables at user-defined intervals. Datalogging up to
eight variables to a USB drive is also available. From the MAIN MENU screen, press TRENDS
(USER) or DATALOG TRENDS (TECH or SETUP). The TREND 1 or DATALOG screen will appear.
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Datalog / Trends (continued)

Trends

0218417

LMY FUEL ACTUATOR '
LMV AIR ACTUATOR 02115f2017

]
09:55:3

aEEs

- . | TIME BASE

o

5

s

I 5 ‘l: T T T | F'_'{—li“ruu

The USB drive must be inserted to use the trend option. Data will be stored for the previous 7
days.

To scroll between the trends, press << and >> beside the title bar.

ON/OFF - Enables or disables the selected trend.
TREND NAVIGATION

e << =Scroll back to view previous trend data. The trend will scroll back by a sample,
second, minute, hour or day depending upon the setting of the
SAMPLES/SECONDS/MINUTES/HOURS/DAYS button. This will pause the trend display
automatically.

e SAMPLES/SECONDS/MINUTES/HOURS/DAYS — Sets the scroll range for viewing
recorded trend data.

e PAUSE - This will pause or play the trend display. 'PAUSED' will display in red text when
paused and touching again will restore the trend to the current display.

e >> —Scroll forward when viewing previous trend data. The trend will scroll back by a
minute, hour or day depending upon the setting of the
SAMPLES/SECONDS/MINUTES/HOURS/DAYS button.

VARIABLES TO LOG (BLUE, RED) — Sets the Modbus register index to trend (TECH required).
MIN, MAX — Sets the range for the trend data (TECH required).

TIME BASE - Select a time base for trending. Choices are 10s, 20s, 30s, 1m, 2m, 5m, 10m, 15m,
30m, 60m (TECH required).

SCCInc. Page 73



Installation Instructions TS Series
Document No. TS-1100

Datalog / Trends (continued)

Datalog
07/21/156 07/21/156
oM TIME BASE TIME BASE
oM
ul ]
ul ]
RESET RESET

OM

R ChG TRENDS TRENDS
OFF

LOG VALUES - Sets the Modbus register index to log (TECH required).

ON/OFF - Enables or disables logging the selected value (TECH required).

TIME BASE - Select a time base for logging. Choices are 10s, 20s, 30s, 1m, 2m, 5m, 10m, 15m,
30m, 60m (TECH required).

START LOG/STOP LOG - Enables or disables all logging (TECH required).

RESET - Sets all log values to '0' (TECH required).

TRENDS — Navigates to the TREND 1 screen (TECH required).

The resulting CSV file is in a tab-separated format and can be viewed with any text editor or
spreadsheet application. On the USB drive, data can be found at:

Path = \PUBLIC\PROJECTS\KITxx\DATA\TEXT, xx is 6 for 6", 10 for 10"

Filename = DATALOG_mm_dd_yyyy.CSV, mmddyyyy are date

A B C D E F
1 SCCInc. Touchscreen Kit Alarm Summary
2 |TSK Model: TS-0XXS-KT Rev. 15F1
3 |Site: Touchscreen Kit
4 Tag:B-1
5
6 |Date Time LMV Phase LMV Fuel Actuator LMV Air Actuator LMV Auxl Actuator
7 9/18/2015 0:26:16 60 74.3 22.6 -12
8 | 9/18/2015 0:26:26 60 74.3 32.6 -12
9 | 9/18/2015 0:26:36 60 74.3 2.6 -12
10 | 9/18/2015 0:26:46 o0 7a.3 22.6 -12
11| 9/18/2015 0:26:56 60 7a.3 52.6 -12
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Register Lookup

Access level: USER / TECH / SETUP

Modbus register indices can be looked up using text strings.

071718 13:52 07721418 14:61

HE R = EERE STRING TO LOOKUP:| LOOKUP

SETTIMNGS

TREMDS : L3 Ik

Enter a string or register index to search, then press LOOKUP.

07721418 16:02 07721418 14:61

STRING TO LOOKUP: |A'CTUAL LOOKUP STRING TO LOOKUP: |A'CTUAL LOOKUP
DESCRIPTION: LMV ACTUAL ¥ALUE DESCRIPTION: [LM¥ ACTUAL ¥ALUE
INDEX:| 12 CURRENT VALUE:| 174 INDEX:| 12 CURRENT VALUE:| 172
NEXT COPY INDEX TO CLIPBOARD NEXT
WHITE:| 0 WRITE

STRING TO LOOKUP - Input the string or register number to search for. Examples are 'FUEL' or
12" (would display the description of index 12).

DESCRIPTION - Displays the full name of the register containing the search string.

INDEX — Displays the index of the register that matches the description.

CURRENT VALUE - Displays the current value of the register. This is a raw value (not scaled).
COPY INDEX TO CLIPBOARD - Copies the register index and matching divider to the clipboard.
This can be pasted into monitored output, trend or datalog configuration (TECH required).
NEXT - Scroll to the next register index matching the description. 'END OF LIST REACHED' will
display if there are no more matching descriptions.

WRITE - Sets the value to manually write to a register. This can be used to test functionality
such as remote setpoint or enables. Press WRITE to apply value (TECH required).
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TS Series

Register Lookup (continued)

Using the Clipboard

If there is data in the clipboard, the configuration screens for the monitored outputs, trends
and the datalog will have corresponding buttons that can be used to paste the data.

OIGITAL OUTFUT S MONITORED WALLE 3
COHDITION 1

2

IF MODEUS ADDHESS[_’ 54
LMY MINUTE

15| =  SETPOINT| s=an
orr () on CONDITION 2

IFMODEUS ADDRESS| 83 /| 1
LM¥ HOUR

(] =] SETFOINT

07/21/16
TIME BEASE

RESET

TRENDS

IF MODEUS ADDRESS

LMY ACTUAL YALUE

ANALOG OUTPUT f MOMITORED WALLE 1
R 11

PASTE INDEX FROM CLIPBOARD |

0 ALARM:

0221772017

TIME BASE
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Screen Captures / USB

Access level: USER

A USB drive can be used to save screen captures, datalogs and to backup Expanded Annunciator
configurations. A display reading 'The USB device is connected.' will appear to confirm that the USB

drive is ready to use.

07421718 15:42

-E0- HORMAL OFERATION

Efficiency 32 8%
Dxygen3 0%

STARTUPS: 56783
- HOURS5:33416

-‘

Output 99 5%

Flue
348"F
Aux-3
14.9"

Ambient
F1"F

¥5D 89.7%

I. Flame 100.0%

|:| The USE dewi connected.

The current screen image may be copied to a USB drive. Any screen may be captured by
pressing the camera icon > 5s until the screen displays 'SNAPSHOT SAVED TO USB'.

07421718 15:44

-E0- HORMAL OFERATION

Efficiency 93 .8%
Dxygen3 9%

Flue
298"F

Ambient

SCC Inc.
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Screen Captures / USB (continued)

If there is no USB drive inserted or there is an error while trying to save the snapshot, a
message will display saying 'SNAPSHOT SAVE ERROR'.

07/21/158 16:10

-60- HORMAL OFERATION

PV 176°F
5P 180°F

GAS

Efficiency 93 0%
Dxygen3. 1%

Flue
340"F

Ambient
F2"F

¥5D 88 7%

If email is configured, an email containing the screen capture as an attachment can be sent by

pressing EMAIL. Note that a USB drive must be inserted to send email since the attached file is
first stored on the USB drive.

On the USB drive, data can be found at:
Path = \PUBLIC\PROJECTS\KITxx\DATA\SNAPSHOT, xx is 6 for 6", 10 for 10"
Filename = SSmmddyyxxxxxx.JPG, mmddyy are date, xxxxxx is sequential number

07/21/15 15:59

-ED- HORMAL OFERATION

PV 173°F
5P 180°F

GAS

Efficiency 93 4%
Dxygen3 5%

_ CLOSE EMAIL :)'= e

Flue
316"F

Ambient
FO"F

¥5D B4 4%

o

HEE SN

There is no limit to the number of screen captures that may be saved to the USB drive other
than the capacity of the USB drive itself.

See the section Configuration (Saved Images) for additional detail on viewing or deleting images
from the touchscreen.
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Changing Passwords
Access level: SETUP

By default, the TECH access level password is 9876 and the SETUP access level password is
START. These default passwords may be changed at any time. To change passwords, press
LOGIN from the main menu. Enter the appropriate information to log in at the SETUP access
level and press APPLY. The CURRENT USER will change to SETUP.

(=Tl (== (=Tt (==

TRENDS : LOG IN 2 ‘ LG OUT

POl FR PMll FR

LCs QLT
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Changing Passwords (continued)
The SETUP password may be changed from this screen. Enter the new password twice and

press APPLY to make the change. To allow the TECH user access to change the TECH password,
press ALLOW PASSWORD CHANGES.

=;

L) sy o T e

(=Tt (== I I

(=Tl (== I I

RESTRICT
PASSWORD

Lios QLT Lios QLT

If password changes have been allowed, the TECH user may now change their password by
following the same procedure as described above for the SETUP user. To disallow the TECH
user from changing the TECH password, press RESTRICT PASSWORD CHANGES.
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Gateway / BMS - Modbus TCP/IP

The standard BMS interface offered is via Modbus TCP/IP. The standard port 502 is used for
this connection. The connection to the BMS is via the Ethernet port on the touchscreen. The
addresses shown are 0-based (begin at 0) and are in decimal format.

Supported function codes:

FC3 (read holding registers), address 0 = 40001.
FC4 (read input registers), address 0 = 30001.
FC6 (single register write), address 0 = 40001.
FC16 (multiple register write), address 0 = 40001.

Addresses with access R are read-only, access RW are read-write.

The following additional protocols are available with an TS Series Protocol Converter (see
Document No. TS-6100 for additional detail):

e BACnet/IP

e BACnetMS/TP

e Metasys N2

e Lonworks

/1 Warning: If the LMVS5 is in firing rate control mode, an external automatic reset
temperature control must be present on the boiler since the internal load control
thermostat function is not active in this mode. Also note that the integrated thermal shock
features do not operate in this mode, so these features must be duplicated if needed.
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Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES
0 R LMV PHASE Unsigned Int 16 see Appendix - LMV Phases
1 R LMV FUEL ACTUATOR Signed Int 16 x10
2 R LMV GAS ACTUATOR Signed Int 16 x10
3 R LMV OIL ACTUATOR Signed Int 16 x10
4 R LMV AIR ACTUATOR Signed Int 16 x10
5 R LMV AUX1 ACTUATOR Signed Int 16 x10
6 R LMV AUX2 ACTUATOR Signed Int 16 x10
7 R LMV AUX3 ACTUATOR Signed Int 16 x10
8 R LMV VSD OUTPUT Unsigned Int 16 x10
9 R LMV CURRENT FUEL Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
10 R LMV CURRENT OUTPUT Unsigned Int 16 x10, see Note 1 below
11 R LMV CURRENT SETPOINT Unsigned Int 16
12 R LMV ACTUAL VALUE Unsigned Int 16
13 R LMV FLAME SIGNAL Unsigned Int 16 x10
14 R LMV FUEL THROUGHPUT Unsigned Int 16
15 R LMV CURRENT O, Unsigned Int 16 x10
16 R LMV GAS UNIT Unsigned Int 16 O=metric,1=standard
17 R LMV OIL UNIT Unsigned Int 16 O=metric,1=standard
18 R LMV TEMPERATURE UNIT Unsigned Int 16 O=metric,1=standard
19 R LMV PRESSURE UNIT Unsigned Int 16 O=metric,1=standard
20 R LMV SENSOR SELECTION Unsigned Int 16 see Note 2 below
21 R LMV STARTUP COUNTER Unsigned Int 32
23 R LMV HOUR COUNTER Unsigned Int 32
25 R LMV CURRENT ERROR CODE Unsigned Int 16 see Appx. - LMVx LO/Err Codes
26 R LMV CURRENT DIAGNOSTIC CODE Unsigned Int 16 see Appx. - LMVx LO/Err Codes
27 R LMV CURRENT ERROR CLASS Unsigned Int 16 not used
28 R LMV CURRENT ERROR PHASE Unsigned Int 16 see Appendix - LMV Phases
29 R LMV TEMP LIMIT OFF THRESHOLD Unsigned Int 16
30 R LMV SUPPLY AIR TEMPERATURE Unsigned Int 16
31 R LMV FLUE GAS TEMPERATURE Unsigned Int 16
32 R LMV COMBUSTION EFFICIENCY Unsigned Int 16 x10
33 R LMV CURRENT CO, Unsigned Int 16 x10
34 R LMV CURRENT EXCESS AIR Unsigned Int 16 x10
35 R LMV INPUT WORD Unsigned Int 16 word of bits
35bit0 R LMV CONTROLLER SWITCH Boolean
35 bit 1 R LMV FAN CONTACTOR Boolean
35 bit 2 R LMV OIL SELECTED Boolean
35 bit 3 R LMV GAS SELECTED Boolean
35 bit 5 R LMV OIL PRESS SW MAX Boolean
35 bit 6 R LMV OIL PRESS SW MIN Boolean
35 bit 7 R LMV VALVE PROVING SW Boolean
35 bit 8 R LMV SAFETY LOOP Boolean
35 bit 10 R LMV GAS PRESS SW MIN Boolean
35 bit 11 R LMV GAS PRESS SW MAX Boolean
35 bit 13 R LMV AIR PRESSURE SW Boolean
35 bit 14 R LMV START RELEASE OIL Boolean
35 bit 15 R LMV HEAVY OIL START Boolean
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Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES
37 R LMV OUTPUT WORD Unsigned Int 16 word of bits
37 bit 0 R LMV ALARM Boolean
37 bit4 R LMV IGNITION Boolean
37 bit 5 R LMV START SIGNAL Boolean
37 bit 6 R LMV FAN OUTPUT Boolean
37 bit 7 R LMV OIL PUMP Boolean
37 bit 8 R LMV FUEL VALVE SV OIL Boolean
37 bit 9 R LMV FUEL VALVE V1 OIL Boolean
37 bit 10 R LMV FUEL VALVE V2 OIL Boolean
37 bit 11 R LMV FUEL VALVE V3 OIL Boolean
37 bit 12 R LMV FUEL VALVE SV GAS Boolean
37 bit 13 R LMV FUEL VALVE V1 GAS Boolean
37 bit 14 R LMV FUEL VALVE V2 GAS Boolean
37 bit 15 R LMV FUEL VALVE PV GAS Boolean
38 RW LMV PROGRAM STOP Unsigned Int 16 see Note 3 below
39 RW LMV LOAD CONTROL MODE Unsigned Int 16 see Note 4 below
40 R LMV MANUAL/AUTOMATIC Unsigned Int 16 O=auto,1=on,2=off
41 RW LMV MODBUS LOCAL/REMOTE Unsigned Int 16 O=local,1=remote
42 RW LMV MODBUS WATCHDOG Unsigned Int 16
43 RW LMV MODBUS OPERATING MODE Unsigned Int 16 O=auto,1=on,2=off
44 RW LMV MODBUS SETPOINT W3 Unsigned Int 16
45 RW LMV MODBUS OUTPUT Unsigned Int 16 x10, see Note 1 below
46 RW LMV MODBUS FUEL SELECTION Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
47 RW LMV SETPOINT W1 Unsigned Int 16
48 RW LMV SETPOINT W2 Unsigned Int 16
49 RW LMV WEEKDAY Unsigned Int 16 0=Sun,1=Mon,2=Tue,etc.
50 RW LMV YEAR 2-DIGIT Unsigned Int 16
51 RW LMV MONTH Unsigned Int 16
52 RW LMV DAY Unsigned Int 16
53 RW LMV HOUR Unsigned Int 16
54 RW LMV MINUTE Unsigned Int 16
55 RW LMV SECOND Unsigned Int 16
56 RW LMV HOURS RUN GAS RESET Unsigned Int 32
58 RW LMV HOURS RUN OIL S1 RESET Unsigned Int 32
60 RW LMV HOURS RUN OIL S2 RESET Unsigned Int 32
62 RW LMV HOURS RUN OIL S3 RESET Unsigned Int 32
64 RW LMV HOURS RUN TOTAL RESET Unsigned Int 32
66 R LMV HOURS RUN TOTAL FIXED Unsigned Int 32
68 R LMV HOURS CONNECTED TO POWER Unsigned Int 32
70 RW LMV STARTUPS GAS RESET Unsigned Int 32
72 RW LMV STARTUPS OIL RESET Unsigned Int 32
74 RW LMV STARTUPS TOTAL RESET Unsigned Int 32
76 R LMV STARTUPS TOTAL FIXED Unsigned Int 32
78 RW LMV TOTAL VOLUME GAS/FUELO Unsigned Int 32
80 RW LMV TOTAL VOLUME OIL/FUEL1 Unsigned Int 32
82 R LMV NUMBER OF LOCKOUTS Unsigned Int 16
83 R LMV EXTRA TEMPERATURE SENSOR Unsigned Int 16
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Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES
84 R LMV AZL5 ASN STRING String (8 words)
92 R LMV AZL5 PARAMETER SET CODE Unsigned Int 16
93 R LMV AZL5 PARAMETER SET VER Unsigned Int 16
94 R LMV AZL5 ID DATE YEAR 2-DIGIT Unsigned Int 16
95 R LMV AZLS5 ID DATE MONTH Unsigned Int 16
96 R LMV AZL5 ID DATE DAY Unsigned Int 16
97 R LMV AZLS ID NUMBER Unsigned Int 16
98 R LMV BURNER CONTROL STRING String (8 words)
106 R LMV BC PARAMETER SET CODE Unsigned Int 16
107 R LMV BC PARAMETER SET VER Unsigned Int 16
108 R LMV BC ID DATE YEAR 2-DIGIT Unsigned Int 16
109 R LMV BC ID DATE MONTH Unsigned Int 16
110 R LMV BURNER CONTROL ID DATE DAY Unsigned Int 16
111 R LMV BURNER CONTROL ID NUMBER Unsigned Int 16
112 R LMV SOFTWARE VERSION AZL Unsigned Int 16 read in hexadecimal
113 R LMV SW VER BURNER CONTROL Unsigned Int 16 read in hexadecimal
114 R LMV SW VER LOAD CONTROL Unsigned Int 16 read in hexadecimal
115 R LMV BURNER ID STRING String (8 words)
123 R LMV MINIMUM OUTPUT GAS Unsigned Int 16 x10, see Note 1 below
124 R LMV MAXIMUM OUTPUT GAS Unsigned Int 16 x10, see Note 1 below
125 R LMV MINIMUM OUTPUT OIL Unsigned Int 16 x10, see Note 1 below
126 R LMV MAXIMUM OUTPUT OIL Unsigned Int 16 x10, see Note 1 below
127 RW LMV LOAD LIMIT MODULATING Unsigned Int 16 x10, see Note 1 below
128 RW LMV LOAD LIMIT STAGING Unsigned Int 16 0=S1,1=S2,2=S3
129 R LMV TEMP LIMIT ON THRESHOLD Signed Int 16 x10, -50% to 0%
130 R LMV RANGE TEMPERATURE SENSOR Unsigned Int 16 0=302F,1=752F,2=1562F
131 R LMV ADAPTION ACTIVE Unsigned Int 16 O=inactive,1=active
132 R LMV ADAPTION STATE Unsigned Int 16 see Note 5 below
133 RW LMV START ADAPTION Unsigned Int 16 O=reset,1=start,2=abort
134 RW LMV ADAPTION OUTPUT Unsigned Int 16 x10
135 RW LMV P-VALUE Unsigned Int 16 x10
136 RW LMV I-VALUE Unsigned Int 16
137 RW LMV D-VALUE Unsigned Int 16
138 R EQUIPMENT FAULTS Unsigned Int 16 word of bits

138 bit 0 R EQUIPMENT FAULT LMV5 Boolean

138 bit 1 R EQUIPMENT FAULT LMV3 Boolean

138 bit 2 R EQUIPMENT FAULT RWF10 LC Boolean

138 bit 3 R EQUIPMENT FAULT RWF40 LC Boolean

138 bit 4 R EQUIPMENT FAULT RWF55 LC Boolean

138 bit 5 R EQUIPMENT FAULT RWF40 FW Boolean

138 bit 6 R EQUIPMENT FAULT RWF55 FW Boolean

138 bit 7 R EQUIPMENT FAULT EA Boolean

138 bit 8 R EQUIPMENT FAULT VSD Boolean
139 RW LOCKOUT STRING CODE TO LOOKUP Unsigned Int 16 see Note 6 below
140 R LOOKUP LOCKOUT CODE STRING String (40 words) see Note 6 below
160 R CURRENT LOCKOUT CODE STRING String (40 words)
180 R CURRENT PHASE STRING String (40 words)
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Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES
200 R LMV5 R40 UNMANIPULATED Unsigned Int 16 0O=auto,1=on,2=off
201 RW REMOTE CONTROL HAND-OFF-AUTO Unsigned Int 16 0O=hand,1=off,2=auto
202 RW REMOTE CONTROL MANUAL MODE Unsigned Int 16 O=inactive,1=active
203 RW REMOTE CONTROL MANUAL OUTPUT Unsigned Int 16 x10
210 R CURRENT FUEL AIR POINT O Unsigned Int 16 x10
211 R CURRENT FUEL AIR POINT 1 Unsigned Int 16 x10
212 R CURRENT FUEL AIR POINT 2 Unsigned Int 16 x10
213 R CURRENT FUEL AIR POINT 3 Unsigned Int 16 x10
214 R CURRENT FUEL AIR POINT 4 Unsigned Int 16 x10
215 R CURRENT FUEL AIR POINT 5 Unsigned Int 16 x10
216 R CURRENT FUEL AIR POINT 6 Unsigned Int 16 x10
217 R CURRENT FUEL AIR POINT 7 Unsigned Int 16 x10
218 R CURRENT FUEL AIR POINT 8 Unsigned Int 16 x10
219 R CURRENT FUEL AIR POINT 9 Unsigned Int 16 x10
220 R CURRENT FUEL AIR POINT 10 Unsigned Int 16 x10
221 R CURRENT FUEL AIR POINT 11 Unsigned Int 16 x10
222 R CURRENT FUEL AIR POINT 12 Unsigned Int 16 x10
223 R CURRENT FUEL AIR POINT 13 Unsigned Int 16 x10
224 R CURRENT FUEL AIR POINT 14 Unsigned Int 16 x10
225 R CURRENT FUEL AIR POINT 15 Unsigned Int 16 x10
226 R CURRENT FUEL AIR POINT 16 Unsigned Int 16 x10
227 R CURRENT FUEL AIR POINT 17 Unsigned Int 16 x10
228 R CURRENT FUEL AIR POINT 18 Unsigned Int 16 x10
229 R CURRENT FUEL AIR POINT 19 Unsigned Int 16 x10
230 R CURRENT FUEL AIR POINT 20 Unsigned Int 16 x10
231 R CURRENT FUEL FUEL POINT O Unsigned Int 16 x10
232 R CURRENT FUEL FUEL POINT 1 Unsigned Int 16 x10
233 R CURRENT FUEL FUEL POINT 2 Unsigned Int 16 x10
234 R CURRENT FUEL FUEL POINT 3 Unsigned Int 16 x10
235 R CURRENT FUEL FUEL POINT 4 Unsigned Int 16 x10
236 R CURRENT FUEL FUEL POINT 5 Unsigned Int 16 x10
237 R CURRENT FUEL FUEL POINT 6 Unsigned Int 16 x10
238 R CURRENT FUEL FUEL POINT 7 Unsigned Int 16 x10
239 R CURRENT FUEL FUEL POINT 8 Unsigned Int 16 x10
240 R CURRENT FUEL FUEL POINT 9 Unsigned Int 16 x10
241 R CURRENT FUEL FUEL POINT 10 Unsigned Int 16 x10
242 R CURRENT FUEL FUEL POINT 11 Unsigned Int 16 x10
243 R CURRENT FUEL FUEL POINT 12 Unsigned Int 16 x10
244 R CURRENT FUEL FUEL POINT 13 Unsigned Int 16 x10
245 R CURRENT FUEL FUEL POINT 14 Unsigned Int 16 x10
246 R CURRENT FUEL FUEL POINT 15 Unsigned Int 16 x10
247 R CURRENT FUEL FUEL POINT 16 Unsigned Int 16 x10
248 R CURRENT FUEL FUEL POINT 17 Unsigned Int 16 x10
249 R CURRENT FUEL FUEL POINT 18 Unsigned Int 16 x10
250 R CURRENT FUEL FUEL POINT 19 Unsigned Int 16 x10
251 R CURRENT FUEL FUEL POINT 20 Unsigned Int 16 x10
252 R CURRENT FUEL VSD POINT O Unsigned Int 16 x10
SCCInc. Page 85




Installation Instructions
Document No. TS-1100

TS Series

Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES

253 R CURRENT FUEL VSD POINT 1 Unsigned Int 16 x10
254 R CURRENT FUEL VSD POINT 2 Unsigned Int 16 x10
255 R CURRENT FUEL VSD POINT 3 Unsigned Int 16 x10
256 R CURRENT FUEL VSD POINT 4 Unsigned Int 16 x10
257 R CURRENT FUEL VSD POINT 5 Unsigned Int 16 x10
258 R CURRENT FUEL VSD POINT 6 Unsigned Int 16 x10
259 R CURRENT FUEL VSD POINT 7 Unsigned Int 16 x10
260 R CURRENT FUEL VSD POINT 8 Unsigned Int 16 x10
261 R CURRENT FUEL VSD POINT 9 Unsigned Int 16 x10
262 R CURRENT FUEL VSD POINT 10 Unsigned Int 16 x10
263 R CURRENT FUEL VSD POINT 11 Unsigned Int 16 x10
264 R CURRENT FUEL VSD POINT 12 Unsigned Int 16 x10
265 R CURRENT FUEL VSD POINT 13 Unsigned Int 16 x10
266 R CURRENT FUEL VSD POINT 14 Unsigned Int 16 x10
267 R CURRENT FUEL VSD POINT 15 Unsigned Int 16 x10
268 R CURRENT FUEL VSD POINT 16 Unsigned Int 16 x10
269 R CURRENT FUEL VSD POINT 17 Unsigned Int 16 x10
270 R CURRENT FUEL VSD POINT 18 Unsigned Int 16 x10
271 R CURRENT FUEL VSD POINT 19 Unsigned Int 16 x10
272 R CURRENT FUEL VSD POINT 20 Unsigned Int 16 x10
273 R CURRENT FUEL AUX POINT O Unsigned Int 16 x10
274 R CURRENT FUEL AUX POINT 1 Unsigned Int 16 x10
275 R CURRENT FUEL AUX POINT 2 Unsigned Int 16 x10
276 R CURRENT FUEL AUX POINT 3 Unsigned Int 16 x10
277 R CURRENT FUEL AUX POINT 4 Unsigned Int 16 x10
278 R CURRENT FUEL AUX POINT 5 Unsigned Int 16 x10
279 R CURRENT FUEL AUX POINT 6 Unsigned Int 16 x10
280 R CURRENT FUEL AUX POINT 7 Unsigned Int 16 x10
281 R CURRENT FUEL AUX POINT 8 Unsigned Int 16 x10
282 R CURRENT FUEL AUX POINT 9 Unsigned Int 16 x10
283 R CURRENT FUEL AUX POINT 10 Unsigned Int 16 x10
284 R CURRENT FUEL AUX POINT 11 Unsigned Int 16 x10
285 R CURRENT FUEL AUX POINT 12 Unsigned Int 16 x10
286 R CURRENT FUEL AUX POINT 13 Unsigned Int 16 x10
287 R CURRENT FUEL AUX POINT 14 Unsigned Int 16 x10
288 R CURRENT FUEL AUX POINT 15 Unsigned Int 16 x10
289 R CURRENT FUEL AUX POINT 16 Unsigned Int 16 x10
290 R CURRENT FUEL AUX POINT 17 Unsigned Int 16 x10
291 R CURRENT FUEL AUX POINT 18 Unsigned Int 16 x10
292 R CURRENT FUEL AUX POINT 19 Unsigned Int 16 x10
293 R CURRENT FUEL AUX POINT 20 Unsigned Int 16 x10
294 R CURRENT FUEL SHOW AIR Unsigned Int 16 0=no,1=yes
295 R CURRENT FUEL SHOW FUEL Unsigned Int 16 0=no,1=yes
296 R CURRENT FUEL SHOW VSD Unsigned Int 16 0=no,1=yes
297 R CURRENT FUEL SHOW AUX Unsigned Int 16 0=no,1=yes
298 R CURRENT FUEL MIN LOAD Unsigned Int 16

299 R CURRENT FUEL MAX LOAD Unsigned Int 16
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300 R RWF LC INPUT WORD Unsigned Int 16

300 bit 12 R RWEF LC INPUT 1 FAULT Boolean

300 bit 13 R RWF LC INPUT 2 FAULT Boolean

300 bit 14 R RWEF LC INPUT 3 FAULT Boolean
301 R RWF LC OUTPUT WORD Unsigned Int 16

301 bit 0 R RWEF LC STAGE MODE Boolean

301 bit 1 R RWF LC MANUAL OPERATION Boolean

301 bit 2 R RWEF LC BINARY INPUT 1 Boolean

301 bit 3 R RWEF LC BINARY INPUT 2 Boolean

301 bit 4 R RWEF LC STAT ACTIVE Boolean

301 bit5 R RWF LC UP ACTIVE Boolean

301 bit 6 R RWEF LC DOWN ACTIVE Boolean

301 bit 7 R RWF LC K6 ACTIVE Boolean
302 R RWF LC E1 Ul6 Unsigned Int 16 x10
303 R RWF LC E2 Ul6 Unsigned Int 16 x10
304 R RWF LC E3 U16 Unsigned Int 16 x10
305 R RWF LC WR U16 CURRENT SP Unsigned Int 16 x10
306 RW RWEF LC SP1 U16 Unsigned Int 16 x10
307 RW RWEF LC SP2 U16 Unsigned Int 16 x10
308 RW RWEF LC AL U16 ALARM SP Unsigned Int 16 x10
309 RW RWF LC PB1 U16 PROPORTIONAL Unsigned Int 16 x10
310 RW RWEF LC DT U16 DERIVATIVE Unsigned Int 16 x10
311 RW RWF LC RT U16 INTEGRAL Unsigned Int 16 x10
312 RW RWF LC HYS1 U16 Unsigned Int 16 x10
313 RW RWF LC HYS3 Ul6 Unsigned Int 16 x10
314 RW RWEF LC DTT U16 WATCHDOG Unsigned Int 16 x10
315 R RWF LC E3 U16 UNFILTERED Unsigned Int 16 x10
316 RW RWF LC REM REMOTE OPERATION Unsigned Int 16 0O=local,1=SP,2=firing rate
317 RW RWF LC ROFF REMOTE OFF Unsigned Int 16 0=on,1=off
318 RW RWEF LC RK1 REM BURNER CONTROL Unsigned Int 16 0=off,1-on
319 RW RWF LC RK6 REMOTE K6 CONTROL Unsigned Int 16 0=off,1-on
320 RW RWEF LC SPR U16 REMOTE SETPOINT Unsigned Int 16 x10
321 RW RWF LC RY U16 REMOTE OUTPUT Unsigned Int 16 x10
322 R RWF LCY U16 OUTPUT Unsigned Int 16 x10
330 R RWF LC E1 FLOAT Float 32
332 R RWEF LC E2 FLOAT Float 32
334 R RWEF LC E3 FLOAT Float 32
336 R RWEF LC WR FLOAT CURRENT SP Float 32
338 RW RWEF LC SP1 FLOAT Float 32
340 RW RWEF LC SP2 FLOAT Float 32
342 RW RWEF LC AL FLOAT ALARM SP Float 32
344 RW RWEF LC PB1 FLOAT PROPORTIONAL Float 32
346 RW RWEF LC DT FLOAT DERIVATIVE Float 32
348 RW RWEF LC RT FLOAT INTEGRAL Float 32
350 RW RWEF LC HYS1 FLOAT Float 32
352 RW RWEF LC HYS3 FLOAT Float 32
354 RW RWEF LC DTT FLOAT WATCHDOG Float 32
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356 RW RWF LC E3 FLOAT UNFILTERED Float 32
358 RW RWEF LC SPR FLOAT REMOTE SETPOINT Float 32
360 RW RWEF LC RY FLOAT REMOTE OUTPUT Float 32
362 R RWEF LCY FLOAT OUTPUT Float 32
370 R RWF FW INPUT WORD Unsigned Int 16

370 bit 12 R RWF FW INPUT 1 FAULT Boolean

370 bit 13 R RWF FW INPUT 2 FAULT Boolean

370 bit 14 R RWF FW INPUT 3 FAULT Boolean
371 R RWF FW OUTPUT WORD Unsigned Int 16

371 bit 0 R RWF FW STAGE MODE Boolean

371bit1 R RWF FW MANUAL OPERATION Boolean

371 bit 2 R RWEF FW BINARY INPUT 1 Boolean

371 bit 3 R RWF FW BINARY INPUT 2 Boolean

371 bit4 R RWF FW STAT ACTIVE Boolean

371 bit5 R RWF FW UP ACTIVE Boolean

371 bit 6 R RWF FW DOWN ACTIVE Boolean

371 bit 7 R RWF FW K6 ACTIVE Boolean
372 R RWF FW LEVEL PERCENT Unsigned Int 16
373 R RWF FW SETPOINT PERCENT Unsigned Int 16
374 R RWF FW E1 U16 Unsigned Int 16 x10
375 R RWF FW E2 U16 Unsigned Int 16 x10
376 R RWF FW E3 U16 Unsigned Int 16 x10
377 R RWF FW WR U16 CURRENT SP Unsigned Int 16 x10
378 RW RWF FW SP1 U16 Unsigned Int 16 x10
379 R RWF FW SP2 U16 Unsigned Int 16 x10
380 R RWF FW Y Ul6 Unsigned Int 16 x10
382 R RWF FW E1 FLOAT Float 32
384 R RWF FW E2 FLOAT Float 32
386 R RWF FW E3 FLOAT Float 32
388 R RWF FW WR FLOAT CURRENT SP Float 32
390 RW RWF FW SP1 FLOAT Float 32
392 R RWF FW SP2 FLOAT Float 32
394 R RWF FW Y FLOAT Float 32
400 R LMV LOCKOUT ERROR CODE CURRENT Unsigned Int 16 see AppX. - LMVx LO/Err Codes
401 R LMV LOCKOUT DIAG CODE CURRENT Unsigned Int 16 see Appx. - LMVx LO/Err Codes
402 R LMV LOCKOUT ERR CLASS CURRENT Unsigned Int 16 not used
403 R LMV LOCKOUT ERR PHASE CURRENT Unsigned Int 16 see Appendix - LMV Phases
404 R LMV LOCKOUT FUEL CURRENT Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
405 R LMV LOCKOUT OUTPUT CURRENT Unsigned Int 16 x10, see Note 1 below
406 R LMV LOCKOUT YEAR 2-DIG CURRENT Unsigned Int 16
407 R LMV LOCKOUT MONTH CURRENT Unsigned Int 16
408 R LMV LOCKOUT DAY CURRENT Unsigned Int 16
409 R LMV LOCKOUT HOUR CURRENT Unsigned Int 16
410 R LMV LOCKOUT MINUTE CURRENT Unsigned Int 16
411 R LMV LOCKOUT SECOND CURRENT Unsigned Int 16
412 R LMV LOCKOUT STARTUPS CURRENT Unsigned Int 32
414 R LMV LOCKOUT HOURS CURRENT Unsigned Int 32

Page 88

SCC Inc.



TS Series

Installation Instructions

Document No. TS-1100

Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES
416 R LMV LOCKOUT ERROR CODE -1 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
417 R LMV LOCKOUT DIAG CODE -1 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
418 R LMV LOCKOUT ERROR CLASS -1 Unsigned Int 16 not used
419 R LMV LOCKOUT ERROR PHASE -1 Unsigned Int 16 see Appendix - LMV Phases
420 R LMV LOCKOUT FUEL -1 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
421 R LMV LOCKOUT OUTPUT -1 Unsigned Int 16 x10, see Note 1 below
422 R LMV LOCKOUT YEAR 2-DIG -1 Unsigned Int 16
423 R LMV LOCKOUT MONTH -1 Unsigned Int 16
424 R LMV LOCKOUT DAY -1 Unsigned Int 16
425 R LMV LOCKOUT HOUR -1 Unsigned Int 16
426 R LMV LOCKOUT MINUTE -1 Unsigned Int 16
427 R LMV LOCKOUT SECOND -1 Unsigned Int 16
428 R LMV LOCKOUT STARTUPS -1 Unsigned Int 32
430 R LMV LOCKOUT HOURS -1 Unsigned Int 32
432 R LMV LOCKOUT ERROR CODE -2 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
433 R LMV LOCKOUT DIAG CODE -2 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
434 R LMV LOCKOUT ERROR CLASS -2 Unsigned Int 16 not used
435 R LMV LOCKOUT ERROR PHASE -2 Unsigned Int 16 see Appendix - LMV Phases
436 R LMV LOCKOUT FUEL -2 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
437 R LMV LOCKOUT OUTPUT -2 Unsigned Int 16 x10, see Note 1 below
438 R LMV LOCKOUT YEAR 2-DIG -2 Unsigned Int 16
439 R LMV LOCKOUT MONTH -2 Unsigned Int 16
440 R LMV LOCKOUT DAY -2 Unsigned Int 16
441 R LMV LOCKOUT HOUR -2 Unsigned Int 16
442 R LMV LOCKOUT MINUTE -2 Unsigned Int 16
443 R LMV LOCKOUT SECOND -2 Unsigned Int 16
444 R LMV LOCKOUT STARTUPS -2 Unsigned Int 32
446 R LMV LOCKOUT HOURS -2 Unsigned Int 32
448 R LMV LOCKOUT ERROR CODE -3 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
449 R LMV LOCKOUT DIAG CODE -3 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
450 R LMV LOCKOUT ERROR CLASS -3 Unsigned Int 16 not used
451 R LMV LOCKOUT ERROR PHASE -3 Unsigned Int 16 see Appendix - LMV Phases
452 R LMV LOCKOUT FUEL -3 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
453 R LMV LOCKOUT OUTPUT -3 Unsigned Int 16 x10, see Note 1 below
454 R LMV LOCKOUT YEAR 2-DIG -3 Unsigned Int 16
455 R LMV LOCKOUT MONTH -3 Unsigned Int 16
456 R LMV LOCKOUT DAY -3 Unsigned Int 16
457 R LMV LOCKOUT HOUR -3 Unsigned Int 16
458 R LMV LOCKOUT MINUTE -3 Unsigned Int 16
459 R LMV LOCKOUT SECOND -3 Unsigned Int 16
460 R LMV LOCKOUT STARTUPS -3 Unsigned Int 32
462 R LMV LOCKOUT HOURS -3 Unsigned Int 32
464 R LMV LOCKOUT ERROR CODE -4 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
465 R LMV LOCKOUT DIAG CODE -4 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
466 R LMV LOCKOUT ERROR CLASS -4 Unsigned Int 16 not used
467 R LMV LOCKOUT ERROR PHASE -4 Unsigned Int 16 see Appendix - LMV Phases
468 R LMV LOCKOUT FUEL -4 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
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469 R LMV LOCKOUT OUTPUT -4 Unsigned Int 16 x10, see Note 1 below
470 R LMV LOCKOUT YEAR 2-DIG -4 Unsigned Int 16
471 R LMV LOCKOUT MONTH -4 Unsigned Int 16
472 R LMV LOCKOUT DAY -4 Unsigned Int 16
473 R LMV LOCKOUT HOUR -4 Unsigned Int 16
474 R LMV LOCKOUT MINUTE -4 Unsigned Int 16
475 R LMV LOCKOUT SECOND -4 Unsigned Int 16
476 R LMV LOCKOUT STARTUPS -4 Unsigned Int 32
478 R LMV LOCKOUT HOURS -4 Unsigned Int 32
480 R LMV LOCKOUT ERROR CODE -5 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
481 R LMV LOCKOUT DIAG CODE -5 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
482 R LMV LOCKOUT ERROR CLASS -5 Unsigned Int 16 not used
483 R LMV LOCKOUT ERROR PHASE -5 Unsigned Int 16 see Appendix - LMV Phases
484 R LMV LOCKOUT FUEL -5 Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
485 R LMV LOCKOUT OUTPUT -5 Unsigned Int 16 x10, see Note 1 below
486 R LMV LOCKOUT YEAR 2-DIG -5 Unsigned Int 16
487 R LMV LOCKOUT MONTH -5 Unsigned Int 16
488 R LMV LOCKOUT DAY -5 Unsigned Int 16
489 R LMV LOCKOUT HOUR -5 Unsigned Int 16
490 R LMV LOCKOUT MINUTE -5 Unsigned Int 16
491 R LMV LOCKOUT SECOND -5 Unsigned Int 16
492 R LMV LOCKOUT STARTUPS -5 Unsigned Int 32
494 R LMV LOCKOUT HOURS -5 Unsigned Int 32
496 R LMV LOCKOUT ERROR CODE -6 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
497 R LMV LOCKOUT DIAG CODE -6 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
498 R LMV LOCKOUT ERROR CLASS -6 Unsigned Int 16 not used
499 R LMV LOCKOUT ERROR PHASE -6 Unsigned Int 16 see Appendix - LMV Phases
500 R LMV LOCKOUT FUEL -6 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
501 R LMV LOCKOUT OUTPUT -6 Unsigned Int 16 x10, see Note 1 below
502 R LMV LOCKOUT YEAR 2-DIG -6 Unsigned Int 16
503 R LMV LOCKOUT MONTH -6 Unsigned Int 16
504 R LMV LOCKOUT DAY -6 Unsigned Int 16
505 R LMV LOCKOUT HOUR -6 Unsigned Int 16
506 R LMV LOCKOUT MINUTE -6 Unsigned Int 16
507 R LMV LOCKOUT SECOND -6 Unsigned Int 16
508 R LMV LOCKOUT STARTUPS -6 Unsigned Int 32
510 R LMV LOCKOUT HOURS -6 Unsigned Int 32
512 R LMV LOCKOUT ERROR CODE -7 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
513 R LMV LOCKOUT DIAG CODE -7 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
514 R LMV LOCKOUT ERROR CLASS -7 Unsigned Int 16 not used
515 R LMV LOCKOUT ERROR PHASE -7 Unsigned Int 16 see Appendix - LMV Phases
516 R LMV LOCKOUT FUEL -7 Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
517 R LMV LOCKOUT OUTPUT -7 Unsigned Int 16 x10, see Note 1 below
518 R LMV LOCKOUT YEAR 2-DIG -7 Unsigned Int 16
519 R LMV LOCKOUT MONTH -7 Unsigned Int 16
520 R LMV LOCKOUT DAY -7 Unsigned Int 16
521 R LMV LOCKOUT HOUR -7 Unsigned Int 16
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522 R LMV LOCKOUT MINUTE -7 Unsigned Int 16
523 R LMV LOCKOUT SECOND -7 Unsigned Int 16
524 R LMV LOCKOUT STARTUPS -7 Unsigned Int 32
526 R LMV LOCKOUT HOURS -7 Unsigned Int 32
528 R LMV LOCKOUT ERROR CODE -8 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
529 R LMV LOCKOUT DIAG CODE -8 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
530 R LMV LOCKOUT ERROR CLASS -8 Unsigned Int 16 not used
531 R LMV LOCKOUT ERROR PHASE -8 Unsigned Int 16 see Appendix - LMV Phases
532 R LMV LOCKOUT FUEL -8 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
533 R LMV LOCKOUT OUTPUT -8 Unsigned Int 16 x10, see Note 1 below
534 R LMV LOCKOUT YEAR 2-DIG -8 Unsigned Int 16
535 R LMV LOCKOUT MONTH -8 Unsigned Int 16
536 R LMV LOCKOUT DAY -8 Unsigned Int 16
537 R LMV LOCKOUT HOUR -8 Unsigned Int 16
538 R LMV LOCKOUT MINUTE -8 Unsigned Int 16
539 R LMV LOCKOUT SECOND -8 Unsigned Int 16
540 R LMV LOCKOUT STARTUPS -8 Unsigned Int 32
542 R LMV LOCKOUT HOURS -8 Unsigned Int 32
544 R LMV ERROR ERROR CODE CURRENT Unsigned Int 16 see Appx. - LMVx LO/Err Codes
545 R LMV ERROR DIAG CODE CURRENT Unsigned Int 16 see Appx. - LMVx LO/Err Codes
546 R LMV ERROR ERROR CLASS CURRENT Unsigned Int 16 not used
547 R LMV ERROR ERROR PHASE CURRENT Unsigned Int 16 see Appendix - LMV Phases
548 R LMV ERROR FUEL CURRENT Unsigned Int 16 0=gas/fuel0,1=0il/fuell
549 R LMV ERROR OUTPUT CURRENT Unsigned Int 16 x10, see Note 1 below
550 R LMV ERROR STARTUPS CURRENT Unsigned Int 32
552 R LMV ERROR ERROR CODE -1 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
553 R LMV ERROR DIAG CODE -1 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
554 R LMV ERROR ERROR CLASS -1 Unsigned Int 16 not used
555 R LMV ERROR ERROR PHASE -1 Unsigned Int 16 see Appendix - LMV Phases
556 R LMV ERROR FUEL -1 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
557 R LMV ERROR OUTPUT -1 Unsigned Int 16 x10, see Note 1 below
558 R LMV ERROR STARTUPS -1 Unsigned Int 32
560 R LMV ERROR ERROR CODE -2 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
561 R LMV ERROR DIAG CODE -2 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
562 R LMV ERROR ERROR CLASS -2 Unsigned Int 16 not used
563 R LMV ERROR ERROR PHASE -2 Unsigned Int 16 see Appendix - LMV Phases
564 R LMV ERROR FUEL -2 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
565 R LMV ERROR OUTPUT -2 Unsigned Int 16 x10, see Note 1 below
566 R LMV ERROR STARTUPS -2 Unsigned Int 32
568 R LMV ERROR ERROR CODE -3 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
569 R LMV ERROR DIAG CODE -3 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
570 R LMV ERROR ERROR CLASS -3 Unsigned Int 16 not used
571 R LMV ERROR ERROR PHASE -3 Unsigned Int 16 see Appendix - LMV Phases
572 R LMV ERROR FUEL -3 Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
573 R LMV ERROR OUTPUT -3 Unsigned Int 16 x10, see Note 1 below
574 R LMV ERROR STARTUPS -3 Unsigned Int 32
576 R LMV ERROR ERROR CODE -4 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
SCClnc. Page 91



Installation Instructions
Document No. TS-1100

TS Series

Gateway / BMS - Modbus TCP/IP (continued)

ADDRESS | ACCESS DESCRIPTION FORMAT NOTES

577 R LMV ERROR DIAG CODE -4 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
578 R LMV ERROR ERROR CLASS -4 Unsigned Int 16 not used
579 R LMV ERROR ERROR PHASE -4 Unsigned Int 16 see Appendix - LMV Phases
580 R LMV ERROR FUEL -4 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
581 R LMV ERROR OUTPUT -4 Unsigned Int 16 x10, see Note 1 below
582 R LMV ERROR STARTUPS -4 Unsigned Int 32

584 R LMV ERROR ERROR CODE -5 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
585 R LMV ERROR DIAG CODE -5 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
586 R LMV ERROR ERROR CLASS -5 Unsigned Int 16 not used
587 R LMV ERROR ERROR PHASE -5 Unsigned Int 16 see Appendix - LMV Phases
588 R LMV ERROR FUEL -5 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
589 R LMV ERROR OUTPUT -5 Unsigned Int 16 x10, see Note 1 below
590 R LMV ERROR STARTUPS -5 Unsigned Int 32

592 R LMV ERROR ERROR CODE -6 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
593 R LMV ERROR DIAG CODE -6 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
594 R LMV ERROR ERROR CLASS -6 Unsigned Int 16 not used
595 R LMV ERROR ERROR PHASE -6 Unsigned Int 16 see Appendix - LMV Phases
596 R LMV ERROR FUEL -6 Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
597 R LMV ERROR OUTPUT -6 Unsigned Int 16 x10, see Note 1 below
598 R LMV ERROR STARTUPS -6 Unsigned Int 32

600 R LMV ERROR ERROR CODE -7 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
601 R LMV ERROR DIAG CODE -7 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
602 R LMV ERROR ERROR CLASS -7 Unsigned Int 16 not used
603 R LMV ERROR ERROR PHASE -7 Unsigned Int 16 see Appendix - LMV Phases
604 R LMV ERROR FUEL -7 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
605 R LMV ERROR OUTPUT -7 Unsigned Int 16 x10, see Note 1 below
606 R LMV ERROR STARTUPS -7 Unsigned Int 32

608 R LMV ERROR ERROR CODE -8 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
609 R LMV ERROR DIAG CODE -8 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
610 R LMV ERROR ERROR CLASS -8 Unsigned Int 16 not used
611 R LMV ERROR ERROR PHASE -8 Unsigned Int 16 see Appendix - LMV Phases
612 R LMV ERROR FUEL -8 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
613 R LMV ERROR OUTPUT -8 Unsigned Int 16 x10, see Note 1 below
614 R LMV ERROR STARTUPS -8 Unsigned Int 32

616 R LMV ERROR ERROR CODE -9 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
617 R LMV ERROR DIAG CODE -9 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
618 R LMV ERROR ERROR CLASS -9 Unsigned Int 16 not used
619 R LMV ERROR ERROR PHASE -9 Unsigned Int 16 see Appendix - LMV Phases
620 R LMV ERROR FUEL -9 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
621 R LMV ERROR OUTPUT -9 Unsigned Int 16 x10, see Note 1 below
622 R LMV ERROR STARTUPS -9 Unsigned Int 32

624 R LMV ERROR ERROR CODE -10 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
625 R LMV ERROR DIAG CODE -10 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
626 R LMV ERROR ERROR CLASS -10 Unsigned Int 16 not used
627 R LMV ERROR ERROR PHASE -10 Unsigned Int 16 see Appendix - LMV Phases
628 R LMV ERROR FUEL -10 Unsigned Int 16 0O=gas/fuel0,1=0il/fuell
629 R LMV ERROR OUTPUT -10 Unsigned Int 16 x10, see Note 1 below
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630 R LMV ERROR STARTUPS -10 Unsigned Int 32

632 R LMV ERROR ERROR CODE -11 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
633 R LMV ERROR DIAG CODE -11 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
634 R LMV ERROR ERROR CLASS -11 Unsigned Int 16 not used
635 R LMV ERROR ERROR PHASE -11 Unsigned Int 16 see Appendix - LMV Phases
636 R LMV ERROR FUEL -11 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
637 R LMV ERROR OUTPUT -11 Unsigned Int 16 x10, see Note 1 below
638 R LMV ERROR STARTUPS -11 Unsigned Int 32

640 R LMV ERROR ERROR CODE -12 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
641 R LMV ERROR DIAG CODE -12 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
642 R LMV ERROR ERROR CLASS -12 Unsigned Int 16 not used
643 R LMV ERROR ERROR PHASE -12 Unsigned Int 32 see Appendix - LMV Phases
644 R LMV ERROR FUEL -12 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
645 R LMV ERROR OUTPUT -12 Unsigned Int 16 x10, see Note 1 below
646 R LMV ERROR STARTUPS -12 Unsigned Int 16

648 R LMV ERROR ERROR CODE -13 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
649 R LMV ERROR DIAG CODE -13 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
650 R LMV ERROR ERROR CLASS -13 Unsigned Int 16 not used
651 R LMV ERROR ERROR PHASE -13 Unsigned Int 16 see Appendix - LMV Phases
652 R LMV ERROR FUEL -13 Unsigned Int 16 0O=gas/fuel0,1=0il/fuell
653 R LMV ERROR OUTPUT -13 Unsigned Int 16 x10, see Note 1 below
654 R LMV ERROR STARTUPS -13 Unsigned Int 32

656 R LMV ERROR ERROR CODE -14 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
657 R LMV ERROR DIAG CODE -14 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
658 R LMV ERROR ERROR CLASS -14 Unsigned Int 16 not used
659 R LMV ERROR ERROR PHASE -14 Unsigned Int 16 see Appendix - LMV Phases
660 R LMV ERROR FUEL -14 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
661 R LMV ERROR OUTPUT -14 Unsigned Int 16 x10, see Note 1 below
662 R LMV ERROR STARTUPS -14 Unsigned Int 32

664 R LMV ERROR ERROR CODE -15 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
665 R LMV ERROR DIAG CODE -15 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
666 R LMV ERROR ERROR CLASS -15 Unsigned Int 16 not used
667 R LMV ERROR ERROR PHASE -15 Unsigned Int 16 see Appendix - LMV Phases
668 R LMV ERROR FUEL -15 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
669 R LMV ERROR OUTPUT -15 Unsigned Int 16 x10, see Note 1 below
670 R LMV ERROR STARTUPS -15 Unsigned Int 32

672 R LMV ERROR ERROR CODE -16 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
673 R LMV ERROR DIAG CODE -16 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
674 R LMV ERROR ERROR CLASS -16 Unsigned Int 16 not used
675 R LMV ERROR ERROR PHASE -16 Unsigned Int 16 see Appendix - LMV Phases
676 R LMV ERROR FUEL -16 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
677 R LMV ERROR OUTPUT -16 Unsigned Int 16 x10, see Note 1 below
678 R LMV ERROR STARTUPS -16 Unsigned Int 32

680 R LMV ERROR ERROR CODE -17 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
681 R LMV ERROR DIAG CODE -17 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
682 R LMV ERROR ERROR CLASS -17 Unsigned Int 16 not used
683 R LMV ERROR ERROR PHASE -17 Unsigned Int 16 see Appendix - LMV Phases
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684 R LMV ERROR FUEL -17 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
685 R LMV ERROR OUTPUT -17 Unsigned Int 16 x10, see Note 1 below
686 R LMV ERROR STARTUPS -17 Unsigned Int 32

688 R LMV ERROR ERROR CODE -18 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
689 R LMV ERROR DIAG CODE -18 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
690 R LMV ERROR ERROR CLASS -18 Unsigned Int 16 not used
691 R LMV ERROR ERROR PHASE -18 Unsigned Int 16 see Appendix - LMV Phases
692 R LMV ERROR FUEL -18 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
693 R LMV ERROR OUTPUT -18 Unsigned Int 16 x10, see Note 1 below
694 R LMV ERROR STARTUPS -18 Unsigned Int 32

696 R LMV ERROR ERROR CODE -19 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
697 R LMV ERROR DIAG CODE -19 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
698 R LMV ERROR ERROR CLASS -19 Unsigned Int 16 not used
699 R LMV ERROR ERROR PHASE -19 Unsigned Int 16 see Appendix - LMV Phases
700 R LMV ERROR FUEL -19 Unsigned Int 16 0=gas/fuel0,1=0il/fuell
701 R LMV ERROR OUTPUT -19 Unsigned Int 16 x10, see Note 1 below
702 R LMV ERROR STARTUPS -19 Unsigned Int 32

704 R LMV ERROR ERROR CODE -20 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
705 R LMV ERROR DIAG CODE -20 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
706 R LMV ERROR ERROR CLASS -20 Unsigned Int 16 not used
707 R LMV ERROR ERROR PHASE -20 Unsigned Int 16 see Appendix - LMV Phases
708 R LMV ERROR FUEL -20 Unsigned Int 16 0O=gas/fuel0,1=oil/fuell
709 R LMV ERROR OUTPUT -20 Unsigned Int 16 x10, see Note 1 below
710 R LMV ERROR STARTUPS -20 Unsigned Int 32

712 R LMV ERROR ERROR CODE -21 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
713 R LMV ERROR DIAG CODE -21 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
714 R LMV ERROR ERROR CLASS -21 Unsigned Int 16 not used
715 R LMV ERROR ERROR PHASE -21 Unsigned Int 16 see Appendix - LMV Phases
716 R LMV ERROR FUEL -21 Unsigned Int 16 O=gas/fuel0,1=0il/fuell
717 R LMV ERROR OUTPUT -21 Unsigned Int 16 x10, see Note 1 below
718 R LMV ERROR STARTUPS -21 Unsigned Int 32

720 R LMV ERROR ERROR CODE -22 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
721 R LMV ERROR DIAG CODE -22 Unsigned Int 16 see Appx. - LMVx LO/Err Codes
722 R LMV ERROR ERROR CLASS -22 Unsigned Int 16 not used
723 R LMV ERROR ERROR PHASE -22 Unsigned Int 16 see Appendix - LMV Phases
724 R LMV ERROR FUEL -22 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
725 R LMV ERROR OUTPUT -22 Unsigned Int 16 x10, see Note 1 below
726 R LMV ERROR STARTUPS -22 Unsigned Int 32

728 R LMV ERROR ERROR CODE -23 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
729 R LMV ERROR DIAG CODE -23 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
730 R LMV ERROR ERROR CLASS -23 Unsigned Int 16 not used
731 R LMV ERROR ERROR PHASE -23 Unsigned Int 16 see Appendix - LMV Phases
732 R LMV ERROR FUEL -23 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
733 R LMV ERROR OUTPUT -23 Unsigned Int 16 x10, see Note 1 below
734 R LMV ERROR STARTUPS -23 Unsigned Int 32

736 R LMV ERROR ERROR CODE -24 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
737 R LMV ERROR DIAG CODE -24 Unsigned Int 16 see AppX. - LMVx LO/Err Codes
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738 R LMV ERROR ERROR CLASS -24 Unsigned Int 16 not used
739 R LMV ERROR ERROR PHASE -24 Unsigned Int 16 see Appendix - LMV Phases
740 R LMV ERROR FUEL -24 Unsigned Int 16 O=gas/fuel0,1=oil/fuell
741 R LMV ERROR OUTPUT -24 Unsigned Int 16 x10, see Note 1 below
742 R LMV ERROR STARTUPS -24 Unsigned Int 32
760 R RWEF EA1 INPUT WORD Unsigned Int 16

760 bit 12 R RWF EA1 INPUT 1 FAULT Boolean

760 bit 13 R RWEF EA1 INPUT 2 FAULT Boolean

760 bit 14 R RWF EA1 INPUT 3 FAULT Boolean
761 R RWF EA1 OUTPUT WORD Unsigned Int 16

761 bit 0 R RWF EA1 STAGE MODE Boolean

761 bit 1 R RWF EA1 MANUAL OPERATION Boolean

761 bit 2 R RWF EA1 BINARY INPUT 1 Boolean

761 bit 3 R RWEF EA1 BINARY INPUT 2 Boolean

761 bit 4 R RWF EA1 STAT ACTIVE Boolean

761 bit 5 R RWF EA1 UP ACTIVE Boolean

761 bit 6 R RWF EA1 DOWN ACTIVE Boolean

761 bit 7 R RWEF EA1 K6 ACTIVE Boolean
762 R RWF EA1 E1 U16 Unsigned Int 16 x10
763 R RWEF EA1 E2 U16 Unsigned Int 16 x10
764 R RWF EA1 E3 U16 Unsigned Int 16 x10
765 R RWF EA1 WR U16 CURRENT SP Unsigned Int 16 x10
766 R RWF EA1 SP1 U16 Unsigned Int 16 x10
767 R RWEF EA1 SP2 U16 Unsigned Int 16 x10
768 R RWF EA1 AL U16 ALARM SP Unsigned Int 16 x10
769 R RWEF EA1 HYS1 U16 Unsigned Int 16 x10
770 R RWF EA1 HYS3 U16 Unsigned Int 16 x10
771 R RWF EA1Y U16 OUTPUT Unsigned Int 16 x10
780 R RWF EA2 INPUT WORD Unsigned Int 16

780 bit 12 R RWF EA2 INPUT 1 FAULT Boolean

780 bit 13 R RWF EA2 INPUT 2 FAULT Boolean

780 bit 14 R RWF EA2 INPUT 3 FAULT Boolean
781 R RWF EA2 OUTPUT WORD Unsigned Int 16

781 bit 0 R RWF EA2 STAGE MODE Boolean

781 bit 1 R RWF EA2 MANUAL OPERATION Boolean

781 bit 2 R RWEF EA2 BINARY INPUT 1 Boolean

781 bit 3 R RWF EA2 BINARY INPUT 2 Boolean

781 bit 4 R RWEF EA2 STAT ACTIVE Boolean

781 bit 5 R RWF EA2 UP ACTIVE Boolean

781 bit 6 R RWF EA2 DOWN ACTIVE Boolean

781 bit 7 R RWF EA2 K6 ACTIVE Boolean
782 R RWF EA2 E1 U16 Unsigned Int 16 x10
783 R RWF EA2 E2 U16 Unsigned Int 16 x10
784 R RWF EA2 E3 U16 Unsigned Int 16 x10
785 R RWF EA2 WR U16 CURRENT SP Unsigned Int 16 x10
786 R RWEF EA2 SP1 U16 Unsigned Int 16 x10
787 R RWF EA2 SP2 U16 Unsigned Int 16 x10
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788 R RWF EA2 AL U16 ALARM SP Unsigned Int 16 x10
789 R RWEF EA2 HYS1 U16 Unsigned Int 16 x10
790 R RWF EA2 HYS3 U16 Unsigned Int 16 x10
791 R RWF EA2 Y U16 OUTPUT Unsigned Int 16 x10
800 R EA DIGITAL INPUT WORD Unsigned Int 16

800 bit 0 R EA INPUT 1 Boolean

800 bit 1 R EA INPUT 2 Boolean

800 bit 2 R EA INPUT 3 Boolean

800 bit 3 R EA INPUT 4 Boolean

800 bit 4 R EA INPUT 5 Boolean

800 bit 5 R EA INPUT 6 Boolean

800 bit 6 R EA INPUT 7 Boolean

800 bit 7 R EA INPUT 8 Boolean

800 bit 8 R EA INPUT 9 Boolean

800 bit 9 R EA INPUT 10 Boolean

800 bit 10 R EA INPUT 11 Boolean

800 bit 11 R EA INPUT 12 Boolean

800 bit 12 R EA INPUT 13 Boolean
801 R EA STATUS WORD Unsigned Int 16

801 bit 0 R EA PUMP PROVEN Boolean

801 bit 1 R EA PUMP ALARM Boolean

801 bit 2 R EA Al1 HIGH ALARM Boolean

801 bit 3 R EA Al1 LOW ALARM Boolean

801 bit 4 R EA Al2 HIGH ALARM Boolean

801 bit 5 R EA Al2 LOW ALARM Boolean

801 bit 6 R EA AI3 HIGH ALARM Boolean

801 bit 7 R EA Al3 LOW ALARM Boolean

801 bit 8 R EA Al4 HIGH ALARM Boolean

801 bit 9 R EA Al4 LOW ALARM Boolean

801 bit 10 R EA AO1 HIGH ALARM Boolean

801 bit 11 R EA AO1 LOW ALARM Boolean

801 bit 12 R EA AO2 HIGH ALARM Boolean

801 bit 13 R EA AO2 LOW ALARM Boolean
802 R EA ALARM WORD Unsigned Int 16

802 bit 0 R EA ALARM INPUT 1 Boolean

802 bit 1 R EA ALARM INPUT 2 Boolean

802 bit 2 R EA ALARM INPUT 3 Boolean

802 bit 3 R EA ALARM INPUT 4 Boolean

802 bit 4 R EA ALARM INPUT 5 Boolean

802 bit 5 R EA ALARM INPUT 6 Boolean

802 bit 6 R EA ALARM INPUT 7 Boolean

802 bit 7 R EA ALARM INPUT 8 Boolean

802 bit 8 R EA ALARM INPUT 9 Boolean

802 bit 9 R EA ALARM INPUT 10 Boolean

802 bit 10 R EA ALARM INPUT 11 Boolean

802 bit 11 R EA ALARM INPUT 12 Boolean

802 bit 12 R EA ALARM INPUT 13 Boolean
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803 R EARTD 1 Unsigned Int 16 x10
804 R EA RTD 2 Unsigned Int 16 x10
805 R EARTD 3 Unsigned Int 16 x10
806 R EA RTD 4 Unsigned Int 16 x10
807 R EA ANALOG INPUT 1 U16 Unsigned Int 16 x10
808 R EA ANALOG INPUT 2 U16 Unsigned Int 16 x10
809 R EA ANALOG INPUT 3 U16 Unsigned Int 16 x10
810 R EA ANALOG INPUT 4 U16 Unsigned Int 16 x10
811 R EA ECONOMIZER WATER IN Unsigned Int 16 x10
812 R EA ECONOMIZER WATER OUT Unsigned Int 16 x10
813 R EA ECONOMIZER STACK IN Unsigned Int 16 x10
814 R EA ECONOMIZER STACK OUT Unsigned Int 16 x10
815 R EA DRAFT FEEDBACK Unsigned Int 16 x10
816 R EA DRAFT ALARM Unsigned Int 16
817 R EA DRAFT ALARM CODE Unsigned Int 16
818 R EA DRAFT ALARM PHASE Unsigned Int 16
819 R EA DRAFT DRIVE WORD Unsigned Int 16

819 bit 0 R EA DRAFT OPEN POSITION Boolean

819 bit 1 R EA DRAFT CLOSE POSITION Boolean

819 bit 2 R EA DRAFT START POSITION Boolean

819 bit 3 R EA DRAFT MODULATE Boolean
820 R EA DRAFT SWITCH Unsigned Int 16 O=open,l=auto
821 R EA DRAFT SENSOR U16 Unsigned Int 16 x10
828 R EA ANALOG INPUT 1 FLOAT Float 32
830 R EA ANALOG INPUT 2 FLOAT Float 32
832 R EA ANALOG INPUT 3 FLOAT Float 32
834 R EA ANALOG INPUT 4 FLOAT Float 32
836 R EA DRAFT SENSOR FLOAT Float 32
838 R EA ANALOG INPUT 1 TOTALIZED Unsigned Int 32 x10
840 R EA ANALOG INPUT 2 TOTALIZED Unsigned Int 32 x10
842 R EA ANALOG INPUT 3 TOTALIZED Unsigned Int 32 x10
844 R EA ANALOG INPUT 4 TOTALIZED Unsigned Int 32 x10
846 R EA MONITOR OUT 1 TOTALIZED Unsigned Int 32 x10
848 R EA MONITOR OUT 2 TOTALIZED Unsigned Int 32 x10
850 R EA LC INPUT WORD Unsigned Int 16

850 bit 0 R EA LC STAT ACTIVE Boolean

850 bit 3 R EA LC K6 ACTIVE Boolean
851 R EA LC OUTPUT WORD Unsigned Int 16

851 bit 4 R EA LC STAT ACTIVE Boolean

851 bit 7 R EA LC K6 ACTIVE Boolean
852 R EALCE1 Ul6 Unsigned Int 16 x10
853 R EALCE3 U16 Unsigned Int 16 x10
854 R EA LC WR U16 CURRENT SP Unsigned Int 16 x10
855 RW EA LCSP1 Ul6 Unsigned Int 16 x10
856 RW EA LCALU16 ALARM SP Unsigned Int 16 x10
857 RW EA LC PB1 U16 PROPORTIONAL Unsigned Int 16 x10
858 RW EA LC DT U16 DERIVATIVE Unsigned Int 16 x10
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859 RW EA LC RT U16 INTEGRAL Unsigned Int 16 x10
860 RW EA LC HYS1 U16 Unsigned Int 16 x10
861 RW EA LC HYS3 U16 Unsigned Int 16 x10
862 RW EA LC REM REMOTE OPERATION Unsigned Int 16
863 RW EA LC ROFF REMOTE OFF Unsigned Int 16
864 RW EA LC RK1 REMOTE BURNER CONTROL Unsigned Int 16
865 RW EA LC SPR U16 REMOTE SETPOINT Unsigned Int 16 x10
866 RW EA LC RY U16 REMOTE OUTPUT Unsigned Int 16 x10
867 R EALCY U16 OUTPUT Unsigned Int 16 x10
868 R EA LC E1 FLOAT Float 32
870 R EA LC E3 FLOAT Float 32
872 R EA LC WR FLOAT CURRENT SP Float 32
874 RW EA LC SP1 FLOAT Float 32
876 RW EA LC AL FLOAT ALARM SP Float 32
878 RW EA LC PB1 FLOAT PROPORTIONAL Float 32
880 RW EA LC DT FLOAT DERIVATIVE Float 32
882 RW EA LC RT FLOAT INTEGRAL Float 32
884 RW EA LC HYS1 FLOAT Float 32
886 RW EA LC HYS3 FLOAT Float 32
888 RW EA LC SPR FLOAT REMOTE SETPOINT Float 32
890 RW EA LC RY FLOAT REMOTE OUTPUT Float 32
892 R EA LCY FLOAT OUTPUT Float 32
900 R VSD FREQUENCY REF PERCENT Unsigned Int 16 x100
901 R VSD OUTPUT FREQUENCY PERCENT Unsigned Int 16 x100
902 R VSD OUTPUT VOLTAGE Unsigned Int 16 x10
903 R VSD DC BUS VOLTAGE Unsigned Int 16
904 R VSD STATUS WORD Unsigned Int 16

904 bit 0 R VSD RUNNING Boolean

904 bit 1 R VSD ZERO SPEED Boolean

904 bit 4 R VSD SPEED AGREE Boolean

904 bit 5 R VSD READY STATE Boolean

904 bit 6 R VSD ALARM STATE Boolean

904 bit 7 R VSD FAULT STATE Boolean
905 R VSD OUTPUT RPM Unsigned Int 16
906 R VSD OUTPUT CURRENT Unsigned Int 16 x100
907 R VSD FREQUENCY REFERENCE HERTZ Unsigned Int 16 x10
908 R VSD OUTPUT FREQUENCY HERTZ Unsigned Int 16 x10
909 R VSD ALARM CODE Unsigned Int 16
910 R VSD FAULT CODE Unsigned Int 16
911 R VSD DC BUS PEAK Unsigned Int 16
912 R VSD OUTPUT CURRENT PEAK Unsigned Int 16
913 R VSD OUTPUT POWER Unsigned Int 16 x1000
914 R VSD TOTALIZED POWER Unsigned Int 32 x100
990 R TSK SOFTWARE MODEL STRING String (5 words)
995 R TSK SOFTWARE VERSION STRING String (2 words)
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Modbus Notes

Note 1 — This value is a percent x10. If the value exceeds 1000, it indicates stages.

1001: 1 stage
1002: 2 stages
1003: 3 stages

Note 2 — LMVS5 sensor selection.

0: Pt100

: Pt1000

: Ni1000

: temperature sensor
: pressure sensor

: Pt100/Pt1000

: Pt100/Ni1000

: no sensor

NOoOO U A, WN R

Note 3 — LMV program stop.

0: deactivated (LMV5, LMV3)

1: prepurge phase 24 (LMV5, LMV3)

2: prepurge FGR phase 32 (LMVS5), ignition position phase 36 (LMV3)
:ignition position phase 36 (LMVS5), interval 1 phase 44 (LMV3)
:interval 1 phase 44 (LMV5), interval 2 phase 52 (LMV3)

:interval 2 phase 52 (LMV5)

: postpurge phase 72 (LMV5)

: postpurge FGR phase 76 (LMV5)

NoOu AW

Note 4 — LMVS5 operating mode.

0: external load control X5-03
1: internal load control
:internal load control bus
:internal load control X62

: external load control X62

: external load control bus

u A WN

SCC Inc.
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Note 5 — LMV5 adaption state.

: undefined

: identification completed, parameter determined

: undefined

: adaption aborted by user

: temperature difference too small, temperature will be lowered with low fire
: monitoring time running

: delivery of identification load set

: error during identification (path)

: error during identification (internal)

: monitoring time running

10: changeover from modulating to multistage during an identification
11: timeout monitoring time

12: timeout heating output on path with monitoring

O o NOOTULEA,WNRO

Note 6 — Lockout code string lookup. Write the lockout code to convert to register 139 as a
decimal number and the string representation will be returned to register 140. For example,

writing '33' to register 139 will result in register 140 returning 'SAFETY LOOP OPEN".
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NUMBER DESCRIPTION
0 LOCKOUT PHASE
1 SAFETY PHASE
2 SAFETY PHASE
10 HOME RUN POSITION
12 STANDBY STATIONARY
20 SAFETY RELAY ON
21 RELEASE OF STARTUP
22 FAN MOTOR ON
24 DRIVE TO PURGE
30 PREPURGE
32 PREPURGE FGR
34 PREPURGE
36 DRIVE TO IGNITION
38 PREIGNITION SPARK ON
39 GAS VALVE TEST MINIMUM PRESSURE
40 PILOT VALVE OPEN
42 SPARK OFF
44 INTERVAL 1 PILOT STABILIZE
50 FUEL VALVE OPEN SAFETY TIME 2
52 PILOT VALVE CLOSED INTERVAL 2 MAIN FLAME
54 DRIVE TO LOW FIRE PRE
60 NORMAL OPERATION
62 DRIVE TO LOW FIRE POST
70 FV CLOSED AFTER BURN TIME
72 DRIVE TO POSTPURGE
74 MANDATORY POSTPURGE
76 MANDATORY POSTPURGE
78 OPTIONAL POSTPURGE
79 DIRECT START (APS CHECK)
80 GV TEST EVACUATION OF TEST SPACE
81 GV TEST ATMOSPHERIC PRESSURE TEST
82 GV TEST FILL TEST SPACE
83 GV TEST PRESSURE TEST
90 GAS SHORTAGE WAITING TIME
97 NO CONFIGURATION
98 WAITING TO ESTABLISH COMMUNICATION
99 COMMUNICATION FAULT

SCC Inc.
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CODE DECIMAL CODE HEX DESCRIPTION
0 0 NO ERROR
1 1 ROM ERROR
2 2 RAM ERROR
3 3 INTERNAL COMMUNICATION ERROR
4 4 UNSUCCESSFUL SYNC OF 2uCs
5 5 FAULT DURING FLAME AMP TEST
6 6 FAULT INTERNAL HARDWARE TEST
16 10 DIGITAL OUTPUT FAULT
17 11 SHORT CIRCUIT CONTACT FEEDBACK
21 15 ACTUATOR FAULT/VSD SPEED NOT REACHED
22 16 FAULT IN RATIO CONTROL SYSTEM
23 17 LMV5 INTERNAL COM ERROR
24 18 CORRUPTION IN COMBUSTION CURVE DATA
25 19 ACTUATOR POT ERROR
26 1A ACTUATOR CURVE TOO STEEP
27 1B ACT CURVE PROG STILL ACTIVE PHASE 62
28 1C ACTUATOR IGNITION POSITION NOT SET
29 1D RUNNING TIME FAULT ACTUATORS/VSD
30 1E ACTUATOR/VSD NOT REACHED POSITION
31 1F VSD MODULE CONNECTION ERROR
33 21 SAFETY LOOP OPEN
34 22 TEMP LIMITER OFF (CHECK SENSOR)
35 23 EXTRANEOUS LIGHT DURING STARTUP
36 24 EXTRANEOUS LIGHT DURING SHUTDOWN
37 25 NO FLAME AT END OF SAFETY TIME
38 26 LOSS OF FLAME PHASE 60-62
39 27 AIR PROVE SW ON SHOULD BE OFF
40 28 AIR PROVE SW OFF SHOULD BE ON
41 29 FAN CONTACT SIGNAL ON SHOULD BE OFF
42 2A FAN CONTACT SIGNAL OFF SHOULD BE ON
43 2B FGR PRESSURE SW ON SHOULD BE OFF
44 2C FGR PRESSURE SW OFF SHOULD BE ON
45 2D CPI (POC) ON SHOULD BE OFF
46 2E CPI (POC) OFF SHOULD BE ON
47 2F LOW GAS PRESSURE SWITCH OPEN
48 30 HIGH GAS PRESSURE SWITCH OPEN
49 31 VALVE PROVE - GAS SIDE LEAK
50 32 VALVE PROVE - BURNER SIDE LEAK
51 33 OIL PRESSURE WHEN OIL PUMP OFF
52 34 LOW OIL PRESSURE WHEN PUMP RUNNING
53 35 HIGH OIL PRESSURE SWITCH OPEN
54 36 NO START RELEASE FOR OIL
55 37 NO HEAVY OIL DIRECT START
56 38 SHORTAGE OF GAS PROGRAM IN PROGRESS
57 39 PARAMETER OF MAX SAFETY TIME FAULTY
58 3A NO BURNER ID DEFINED
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CODE DECIMAL CODE HEX DESCRIPTION
59 3B NO SERVICE PASSWORD DEFINED
64 40 WRONG CONTACT POSITION OF SAFETY TIME
65 41 WRONG CONTACT POSITION OF IGNITION
66 42 WRONG CONTACT POSITION OF FUEL RELAY
67 43 PLAUSIBILITY CHECK FAULT
68 44 FAULT AT DEACTIVATED INPUTS
69 45 SHUTDOWN VIA SAFETY LIMIT TEST
70 46 PROGRAM STOP ACTIVATED
71 47 START RELEASE GAS IS OFF
72 48 TWO FLAME SIGNALS WITH ONE PARMETERIZED
80 50 FAULT DURING KEY VALUE CHECK
81 51 TIME BLOCK OVERFLOW
82 52 STACK ERROR
83 53 FAULTY RESET STATE OCCURRED
88 58 INTERNAL COMMUNICATION (uC1<>uC2)
89 59 EEPROM PAGE IS ON ABORT
90 5A CRC ERROR OF PARAMETER RANGE
91 5B PAGE ON ABORT
92 5C PAGE ON WR_RESTO (BACKUP RESTORE MADE)
93 5D PAGE OPEN TOO LONG
94 5E PAGE HAS UNDEFINED STATUS
95 5F LAST BACKUP RESTORE INVALID (INTERRUPTED)
96 60 FAULT COPYING A PARAMETER PAGE
97 61 FAULT WITH EEPROM INITIALIZATION
112 70 FAULT DURING RESTORING LOCKOUT INFO
113 71 MANUAL LOCKOUT VIA CONTACT
114 72 PLAUSIBILITY FAULT WITH FAULT ENTRY
128 80 WRONG STATE OF AUX3 ACTUATOR
129 81 WRONG STATE OF AIR ACTUATOR
130 82 WRONG STATE OF GAS ACTUATOR
131 83 WRONG STATE OF OIL ACTUATOR
132 84 WRONG STATE OF AUX1 ACTUATOR
133 85 WRONG STATE OF AUX2 ACTUATOR
134 86 WRONG STATE OF INTERNAL LOAD CONTROLLER
135 87 WRONG STATE OF AZL
136 88 PLAUSIBILITY FAULT (NMT)
144 90 ROM-CRC ERROR ON AUX3 FEEDBACK
145 91 ROM-CRC ERROR ON AIR FEEDBACK
146 92 ROM-CRC ERROR ON GAS FEEDBACK
147 93 ROM-CRC ERROR ON OIL FEEDBACK
148 94 ROM-CRC ERROR ON AUX1 FEEDBACK
149 95 ROM-CRC ERROR ON AUX2 FEEDBACK
150 96 ROM-CRC ERROR ON LC FEEDBACK
151 97 ROM-CRC ERROR ON AZL FEEDBACK
152 98 CANBUS DEVICE WITH SAME ADDRESS CONFLICT
153 99 CANBUS IS OFF
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CODE DECIMAL CODE HEX DESCRIPTION
154 9A CANBUS WARNING LEVEL
155 9B CANBUS QUEUE OVERRUN
160 AO AUX3 ACTUATOR DETECTED A FAULT
161 Al AIR ACTUATOR DETECTED A FAULT
162 A2 GAS ACTUATOR DETECTED A FAULT
163 A3 OIL ACTUATOR DETECTED A FAULT
164 A4 AUX1 ACTUATOR DETECTED A FAULT
165 A5 AUX2 ACTUATOR DETECTED A FAULT
166 A6 LOAD CONTROL DETECTED A FAULT
167 A7 AZL DETECTED A FAULT
169 A9 VSD MODULE DETECTED A FAULT
171 AB O, MODULE DETECTED A FAULT
176 BO FAULT DURING TEST OF PORT OUTPUTS
177 B1 FAULT DURING SHORT CIRCUIT TEST
181 B5 O, MONITOR FAULT
186 BA O, SENSOR TEST FAILED
191 BF O, CONTROL AUTO DEACTIVATION
197 C5 AZL HAS DETECTED OLD UNIT VERSIONS
209 D1 WRONG STATE OF VSD MODULE
211 D3 WRONG STATE OF O, MODULE
225 El ROM-CRC ERROR ON VSD MODULE FEEDBACK
227 E3 ROM-CRC ERROR ON O, MODULE FEEDBACK
240 FO PLAUSIBILITY FAULT (INTERPOLATION)
241 F1 FAULT CALCULATING PRECONTROL
242 F2 FAULTY TEMP VALUES FROM O, MODULE
87 57 INVALID PARAMETERIZATION
187 BB O, TRIM CONTROL REMOVED
190 BE INVALID PARAMETERIZATION O, CONTROL
243 F3 O, TRIM CONTROL FAULT
244 F4 0O, MODULE FAULT (FGR)
245 F5 CANBUS FEEDBACK FAULT X60 TEMP INPUT
246 F6 FGR FAULT
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CODE DESCRIPTION
2 NO FLAME AT END OF SAFETY TIME
3 AIR PRESSURE FAILURE
4 EXTRANEOUS LIGHT
7 LOSS OF FLAME

12 VALVE PROVING

14 PROOF OF CLOSURE

19 COMBUSTION PRESSURE POC
20 PRESSURE SWITCH - MINIMUM

21 PRESSURE SWITCH - MAXIMUM

22 SAFETY LOOP / BURNER FLANGE

50 INTERNAL ERROR

51 INTERNAL ERROR

55 INTERNAL ERROR

56 INTERNAL ERROR

57 INTERNAL ERROR

58 INTERNAL ERROR

60 INTERNAL ERROR - NO VALID HEAT SOURCE
61 FUEL CHANGEOVER

62 INVALID FUEL SIGNALS OR INFORMATION

65 INTERNAL ERROR

66 INTERNAL ERROR

67 INTERNAL ERROR

70 INTERNAL ERROR - FUEL/AIR RATIO CONTROL
71 SPECIAL POSITION UNDEFINED

72 INTERNAL ERROR - FUEL/AIR RATIO CONTROL
73 INTERNAL ERROR - FUEL/AIR RATIO CONTROL
75 INTERNAL ERROR - FUEL/AIR RATIO CONTROL
76 INTERNAL ERROR - FUEL/AIR RATIO CONTROL

80 CONTROL RANGE LIMIT OF VSD
81 VSD ELECTROMAGNETIC INTERFERENCE

82 ERROR DURING VSD SPEED STANDARDIZATION
83 SPEED ERROR VSD

84 CURVE SLOPE ACTUATORS

85 ACTUATOR REFERENCING ERROR

86 ERROR FUEL ACTUATOR

87 ERROR AIR ACTUATOR

90 INTERNAL ERROR - BASIC UNIT

91 INTERNAL ERROR - BASIC UNIT

93 ERROR FLAME SIGNAL ACQUISITION

95 ERROR RELAY SUPERVISION

96 ERROR RELAY SUPERVISION

97 ERROR RELAY SUPERVISION

98 ERROR RELAY SUPERVISION

99 INTERNAL ERROR - RELAY CONTROL

100 INTERNAL ERROR - RELAY CONTROL

105 INTERNAL ERROR - CONTACT SAMPLING
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Appendix - LMV3 Error Codes (continued)

CODE DESCRIPTION
106 INTERNAL ERROR - CONTACT REQUEST
107 INTERNAL ERROR - CONTACT REQUEST
108 INTERNAL ERROR - CONTACT REQUEST
110 INTERNAL ERROR - VOLTAGE MONITOR TEST
111 POWER FAILURE
112 MAINS VOLTAGE RECOVERY
113 INTERNAL ERROR - MAINS VOLTAGE
115 INTERNAL ERROR - SYSTEM COUNTER
116 DESIGN THRESHOLD EXCEEDED
117 LIFETIME EXCEEDED - OPERATION NOT ALLOWED
120 FUEL METERING INTERFERENCE
121 INTERNAL ERROR - EEPROM ACCESS
122 INTERNAL ERROR - EEPROM ACCESS
123 INTERNAL ERROR - EEPROM ACCESS
124 INTERNAL ERROR - EEPROM ACCESS
125 INTERNAL ERROR - EEPROM READ ACCESS
126 INTERNAL ERROR - EEPROM WRITE ACCESS
127 INTERNAL ERROR - EEPROM ACCESS
128 INTERNAL ERROR - EEPROM ACCESS
129 INTERNAL ERROR - EEPROM ACCESS
130 INTERNAL ERROR - EEPROM ACCESS
131 INTERNAL ERROR - EEPROM ACCESS
132 INTERNAL ERROR - EEPROM REG INITIALIZATION
133 INTERNAL ERROR - EEPROM REQUEST SYNC
134 INTERNAL ERROR - EEPROM REQUEST SYNC
135 INTERNAL ERROR - EEPROM REQUEST SYNC
136 RESTORE STARTED
137 INTERNAL ERROR - BACKUP/RESTORE
146 TIMEOUT - BAS MODBUS
150 TUV TEST
165 INTERNAL ERROR
166 INTERNAL ERROR - WATCHDOG TEST
167 MANUAL LOCKING
168 INTERNAL ERROR - MANAGEMENT
169 INTERNAL ERROR - MANAGEMENT
170 INTERNAL ERROR - MANAGEMENT
171 INTERNAL ERROR - MANAGEMENT
200 NO ERROR
201 PREVENTION OF STARTUP
202 INTERNAL ERROR - OPERATING MODE SELECT
203 INTERNAL ERROR
204 PROGRAM STOP
205 INTERNAL ERROR
206 COMBINATION OF UNITS NOT ALLOWED
207 AZL VERSION COMPATIBILITY ERROR
208 INTERNAL ERROR
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Appendix - LMV3 Error Codes (continued)

CODE DESCRIPTION
209 INTERNAL ERROR
210 SELECTED MODE NOT RELEASED FOR BASIC UNIT
240 INTERNAL ERROR
245 INTERNAL ERROR
250 INTERNAL ERROR

SCC Inc.
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Appendix - Yaskawa VSD Alarm Codes

CODE DESCRIPTION CODE DESCRIPTION
0 No Alarm 24 Drive Overload (olL2)
1 Undervoltage (Uv1) 26 Option Card Ext. Fault (EFO)
2 Overcurrent (oC) 27 Cmd. Input During Run (rUn)
3 Heatsink Overheat (oH) 29 Serial Comm. Error (CALL)
4 Drive Overheat (oH2) 30 Undertorque 1 (UL3)
5 Overtorque 1 (oL3) 31 Undertorque 2 (UL4)
6 Overtorque 2 (oL4) 32 Modbus Test Mode Fault (SE)
7 Run Cmd. Input Error (EF) 34 Motor Overheat (oH3)
8 Drive Baseblock (bb) 39 PID Feedback Loss (FbL)
9 Ext. Fault Input S3 (EF3) 40 PID Feedback Loss (FbH)
10 Ext. Fault Input S4 (EF4) 42 Drive Disabled (dnE)
11 Ext. Fault Input S5 (EF5) 43 PG Disconnected (PGo)
12 Ext. Fault Input S6 (EF6) 49 Watchdog Timer Error (E5)
13 Ext. Fault Input S7 (EF7) 50 Station Address Error (AEr)
15 Reserved 51 Comm. Cycle Error (CyC)
16 Overspeed (0S) 52 High Current Alarm (HCA)
17 Excessive Speed Dev. (dEv) 57 Ext. Fault Input S1 (EF1)
18 PG Disconnected (PGo) 58 Ext. Fault Input S2 (EF2)
19 Dig. Operator Connect (oPr) 59 Safe Disable Input (HbbF)
20 Modbus Error (CE) 60 Safe Disable Input (Hbb)
21 Option Comm. Error (bUS) 61 Mech. Weakening 1 (oL5)
22 Serial Comm. Error (CALL) 62 Mech. Weakening 2 (UL5)
23 Motor Overload (oL1) 73 DriveWorksEZ Alarm (dWAL)
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Appendix - Yaskawa VSD Fault Codes

CODE DESCRIPTION CODE DESCRIPTION
0 No Fault 29 Motor Overheat (oH3)
2 Undervoltage (Uv1) 30 Dig. Operator Connect (oPr)
3 PS Undervoltage (Uv2) 31 EEPROM Write Error (Err)
4 Soft Charge Fault (Uv3) 32 Motor Overheat (oH4)
5 IGBT Short Circuit (SC) 33 Modbus Error (CE)
6 Ground Fault (GF) 34 Option Comm. Error (bUS)
7 Overcurrent (oC) 37 Control Fault (CF)
8 Overvoltage (ov) 39 PROFIBUS-DP Fault (EFO)
9 Heatsink Overheat (oH) 40 PID Feedback Loss (FbL)
10 Heatsink Overheat (oH1) 41 Undertorque 1 (UL3)
11 Motor Overload (oL1) 42 Undertorque 2 (UL4)
12 Drive Overload (oL2) 43 High Slip Braking OL (oL7)
13 Overtorque 1 (oL3) 48 Hardware Fault (oFx)
14 Overtorque 2 (oL4) 54 Output Curr. Imbalance (LF2)
15 Dyn. Braking Transistor (rr) 55 Pullout Detection (Sto)
16 Braking Res. Overheat (rH) 56 PG Disconnect (PGo)
17 Ext. Fault Input S3 (EF3) 57 Watchdog Timer Error (E5)
18 Ext. Fault Input S4 (EF4) 59 Too Many Restarts (SEr)
19 Ext. Fault Input S5 (EF5) 65 PID Feedback Loss (FbH)
20 Ext. Fault Input S6 (EF6) 66 Ext. Fault Input S1 (EF1)
21 Ext. Fault Input S7 (EF7) 67 Ext. Fault Input S2 (EF2)
24 Overspeed (0S) 68 Mech. Weakening 1 (oL5)
25 Excessive Speed Dev. (dEv) 69 Mech. Weakening 2 (UL5)
26 PG Disconnect (PGo) 70 Current Offset Fault (CoF)
27 Input Phase Loss (PF) 73 DriveWorksEZ Fault (dWFL)
28 Output Phase Loss (LF) 131 A/D Conversion Error (CPF02)

SCC Inc.
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Appendix - Hand-Off-Auto Flowchart

CHand-Oﬁ-Amo H\.I
Switch !
s
- i = S
| Hand Auto )u
Y v
s
Manual? [ Off | Comms Active?
. /
Y
Local/Remote (41) = Remote
Remote Mode (43) = Off
W3 Setpoint (44) = W1 Setpoint
Remote Qutput (45) = N/A
v : s 5 L
|/ Active ' '/ Inactive \ o« I‘/ Active
i L -
Y Y A
Local/Remote (41) = Remote Local/Remote (41) = Local Local/Remote (41) = From BMS / LLM
Remote Mode [43) = On Remote Mode (43) = N/A Remote Mode (43) = From BMS / LLM
W3 Setpeint (44) = W1 Setpoint W3 Setpoint (44) = Nf/A W3 Setpoint (44) = From BMS / LLM
Remote Output (45) = Manual Cutput Remote Output (45) = NfA Remote Qutput (45) = From BMS / LLM
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Appendix - Logic Definitions

|J>
=2
o

Vs

CONDITION 1 | CONDITION 2 RESULT CONDITION 1 | CONDITION 2 RESULT
FALSE FALSE FALSE FALSE FALSE FALSE
FALSE TRUE FALSE FALSE TRUE TRUE
TRUE FALSE FALSE TRUE FALSE TRUE
TRUE TRUE TRUE TRUE TRUE TRUE

NAND NOR

CONDITION 1 | CONDITION 2 RESULT CONDITION 1 | CONDITION 2 RESULT
FALSE FALSE TRUE FALSE FALSE TRUE
FALSE TRUE TRUE FALSE TRUE FALSE
TRUE FALSE TRUE TRUE FALSE FALSE
TRUE TRUE FALSE TRUE TRUE FALSE

XOR XNOR

CONDITION 1 | CONDITION 2 RESULT CONDITION 1 | CONDITION 2 RESULT
FALSE FALSE FALSE FALSE FALSE TRUE
FALSE TRUE TRUE FALSE TRUE FALSE
TRUE FALSE TRUE TRUE FALSE FALSE
TRUE TRUE FALSE TRUE TRUE TRUE
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Appendix - Activation

Software upgrades to the touchscreen and/or Expanded Annunciator may require that an
activation code is entered following the download. If the touchscreen is started without
activation, the activation screen will appear. The touchscreen will automatically proceed to the
OPTIONS screen for configuration once activated (see Configuration section for additional
detail).

THIS PANEL 1S NOT ACTIVATED.
Please contact SCC, Inc.
Technical Support (contact info
at www. scccombustion.com)
with the following code to get
the correct licensing key.

ICode: 1972 I

Enter: ‘ 0 APPLY

If the Expanded Annunciator is not activated, the activation screen will automatically appear
when attempting to navigate to any Expanded Annunciator screen.

[—] [——]
t EA NOT ACTIVATED t EA ACTIVATED!
|Code: 4457 I Code: 4457
Enter: ‘ 0 Enter: 438906702
EXIT EXIT
Lo S

Lo

Contact SCC, Inc. technical support with the code listed and an activation key will be provided.
Once it is entered, press APPLY.

Page 112 SCCInc.



TS Series Installation Instructions
Document No. TS-1100

Appendix - Email Options

Additional email options are available by pressing EMAIL SETUP for >5s. This displays the
EMAIL MANUAL screen.

SUBJECT

MESSAGE

| RESTORE | | SAYE TD

senn resTeMa || 2ol eal | s [wanwene] [ Ewiai seRveR sermings ]

A custom email message can be sent from this screen. Enter a subject and a message (100
characters or less). Press SEND EMAIL to send the message.

SO HIHLELE

Press EMAIL SERVER SETTINGS to display the EMAIL SERVER screen. The default email server
settings can be changed if required or directed. Press RESTORE SCC DEFAULTS to restore the
server settings to the factory defaults. Note that if using the default settings, the return
address cannot be changed or the mail server will reject the message.

Server

Username

Return Address

Port
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Appendix - ACS 800 Software

Setting Up Connections

ACS 800 connects to the Touchscreen Kit and connected Expanded Annunciator using an
Ethernet connection. The computer running ACS 800 must be on the same physical network as
the associated devices. The IP addresses of the devices must be known before a connection can
be established.

To configure the IP address for the Touchscreen Kit, click Connection -> Boiler Designation to
bring up the options.

- s

File | Connection | View Help

Boiler Designation 3 ‘ Other  » | |192.168.l.60 | I
Expanded Annunciator 3 B-1
B-2
B-3
B-4
B-5
B-6
B-7
B-8

Connect

Disconnect

Allow Remote Operation

Refresh View

Match the address to the one programmed in the Touchscreen Kit.

If an Expanded Annunciator is optioned, click Connection -> Expanded Annunciator to bring up
the options.

A ———————
File | Connection | View Help

Boiler Designation 3

| Expanded Annunciator 3 | Other » | |192.168‘1.59 | I
Connect E Standalone
Disconnect Lead/Lag

Allow Remote Operation

Refresh View

The IP address is determined by the application. Choose this based upon whether the
Touchscreen Kit is connected to an SCC, Inc. Lead/Lag Master.

Once both IP addresses are configured, click Connect to establish communication. The
communication status will display on the bottom of the screen in the status bar.
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Appendix - ACS 800 Software (continued)

Viewing Operation With Dashboard

The operating status of the Touchscreen Kit can be viewed if communication is established. To
open the dashboard, click View -> Online Dashboard.

File Connection View Help

Ovenview | LMV Data | LMV History | Expanded Annunciator

-60- NORMAL OPERATION

o Program Stop: Deactivated

PV 104PSI - ‘ Deactivated oply
SP 99PSI it
e = 242°F

STARTUPS: 56825 A3

Ambient . HOURS: 33974 0.8°

69°F Efficiency
02
- 55%
Output 57.5% co2
8.2%
Excess Air
Air 31.9%
345

711%  Fuel
4817

Remote Mode: Bumer On HAND | 00 ) [ Aosly
Remote Setpoint: 99PSI
Remote Firi:; Rate: 100.0% | Q ‘ OFF Activate Manual

LEAD/LAG NOT CONNECTED AUTO | | Deactivate Manual

Touchscreen Kit: Communication With BOILER | Expanded Annunciator: Communication Active

The tabs at the top of the dashboard allow viewing of the following operating data when
optioned:

e Qverview

e LMV Data

e LMV History

e Feedwater

e VSD

e Expanded Annunciator Inputs and Outputs

e Draft Control via Expanded Annunciator

e Economizer via Expanded Annunciator

e Extra RWF55 Controls via Expanded Annunciator

If the LMV is in a lockout, clicking on the lockout message on the Overview tab will display the
error code help file with the top of the help window lined up with the current code.
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Appendix - ACS 800 Software (continued)

Remote Operation

Some remote operation of the Touchscreen Kit is possible:

Hand-Off-Auto Switch
Manual Firing Rate
Program Stop

By default, remote operation is not allowed. To enable remote operation, click Connection ->
Allow Remote Operation. Acknowledge the safety warning to complete the process.

oc! ACS 800

File

Connection | View  Help

Boiler Designation
Expanded Annunciator

Connect

Disconnect

I Allow Rernote Operation I
Refresh View

Safety Warning @

WARNING - PLEASE READ

Take precautions so that unintended equipment
operation will not cause bodily injury or equipment
damage.

Complete understanding of the connected equipment
and system is required for remote operation.

Failure to follow these instructions may result
in death, bodily injury or equipment damage.

I [ Iunderstand and acknowledge this waming I
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Saving Operating Data To Files

The following operating data can be saved to file:

e LMV Data (static data such as ID numbers and versions used to identify unit)
To save: File -> Save LMV Data to File
e LMV Stats (fuel statistics such as startups, hours and totalization)
To save: File -> Save LMV Stats to File
e LMV Fault History
To save: File -> Save LMV Fault History to File
e LMV Lockout History (LMV5 only)
To save: File -> Save LMV Lockout History to File

lgg ACS 800 - Online ME!

File | Connection View Help

Print Screen

Print Preview

— K

Page Setup 3

Save LMV Data to File
Save LMY Stats to File
Save LMV Fault History to File

Save LMV Lockout History to File
B ) i~ - | i ] [i1]
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Appendix - ACS 800 Software (continued)

Printing Data

Data on the screen can be printed.

To set the margins: File -> Page Setup -> Margins -> (Left, Right, Top or Bottom)
To set the orientation: File -> Page Setup -> Orientation -> (Landscape or Portrait)
To set the scale: File -> Page Setup -> Scale -> (%)

Selecting Auto-Fit for the scale will have the screen data fill the page to the margins while
maintaining the proper ratio. Click File -> Print Preview to view the output and click
File -> Print Screen to choose a printer and complete the process.

a2 ACS 800 - Online

File | Connection View Help

Print Screen

Print Preview

| Page Setup 5 Margins »
Save LMV Data to File Orientation DCO PH:6l(
Save LMV Stats to File Scale > 259,
Save LMV Fault History to File 50%

Save LMV Lockout History to File
= IIJr ol

GAS

Ambient
68°F
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Appendix - ACS 800 Software (continued)

Logging Operation Data To File

Up to eight data points may be logged in intervals ranging from 1-9999 seconds, 1-9999
minutes or 1-999 hours. Click View -> Online Datalog Setup to display the setup screen. The
data points are derived from the Modbus registers in the Touchscreen Kit and are presented in
a drop-down list.

File  Connection View Datalog Help

Timebase |10 =

Current Path: C:\Userscardo SCC\Deskiop

Log Value 1
Active [1 - LMV FUEL ACTUATOR.

Log Value 2
Active [4 - LMV AIR ACTUATOR

Log Value 3
[T Active

Log Value 4
[T Active

Log Value 5
[T Active

Log Value &
[ Active

Log Value 7
[ Active

Log Value &
[ Active

Touchscreen Kit: Communication With BOILER | Expanded Annunciator: Communication Active

Once the desired logging data is configured, click Datalog -> Choose File Path to specify where
the data should be stored. Click Datalog -> Start Logging to begin logging the data.

5 ACS 800 - Online

File Connection View | Datalog | Help

Choaose File Path

Timebase |10 = [ Start Legging

Cumrent Path: C:\Users Stop Legging

SCCInc. Page 119



Installation Instructions
Document No. TS-1100

TS Series

Appendix - ACS 800 Software (continued)

When data logging is active, the status bar icon will turn from grey to green.

To turn the logging off, click Datalog -> Stop Logging.

G- ACS 800 - Online

File  Connection View | Dataleg | Help

Choose File Path

Timebase |10 = [ Start Logging

Cumrent Path:  C:\Users I Stop Logging I
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Viewing Combustion Curve From Device

If communication is active, the combustion curve saved in the device can be viewed by clicking
View -> Online Combustion Curve.

File  Connection View Help

— Air Actuator

— Fuel Actuator

— V5D Percent
Auze Actuator

=
&
g
&
o
5
-2
=
&
a
5
E
E
£
L4

50% 60% 70% 80%

Percent Load

Touchscreen Kit: Communication With BOILER | Expanded Annunciator. Communication Active

If no combustion curve is saved, this will be indicated at the top of the graph display as 'NO
CURVE COMMISSIONED AT TOUCHSCREEN KIT".
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Viewing Combustion Curve From File

A combustion curve saved from a Touchscreen Kit can be viewed from the file by clicking
View -> Offline Combustion Curve.

File  Connection View | Offline Combustion Curve | Help

Select File '

To select a file to view, click Offline Combustion Curve -> Select File. Once the file is loaded, the
Offline Combustion Curve menu will show the available fuel curves to view.

File

Connection  View | Offline Combustion Curve

Select File

Fuel 0: GAS
Fuel 1: OIL (Mot Commissioned)

Click on the desired fuel curve to display the graph.

File  Connection View Help

100 —— Air Actuator

= Fuel Actuator
— VSD Percent
%0 z Aux Actuator

a0

70 — -

60

50 == -

40

Angular Degrees or Percent

0 Yl

20

st
,/
>

10% 20% 30% 40% 50% 60% 70% 80% 90% 100%

Percent Load

Touchscreen Kit: Communication With BOILER. | Expanded Annunciator: Communication Active
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Viewing Logged Operation Data From File

Data logged from a Touchscreen Kit or from the ACS 800 software can be viewed by clicking
View -> Offline Datalog Viewer. Click Datalog -> Select File to choose the file to view.

File Connection View | Datalog | Help
Select File

Once the file has loaded, it will show the first ten entries. To expand the graph, change the
'View Start' and/or 'View Stop' times using the drop-down list.

(e ACS 200 - Offiine Datalog Views

File Connection View Datalog Help

View Start [ 11/11/2015 09:51.05 ~|
View Stop [ 11/11/2015 09:51:14 -]

120 — 1: LMV FUEL ACTUATOR

— 2: LMV AIR ACTUATOR

— 3: LMV CURRENT SETPOINT
4: LMV ACTUAL VALUE

(=]

1111172015
09:51.05
11411152015
09:51.06
111152015
09:51.07
1111152015
09:51.08
111152015
09:51.09
1111152015
09:51:10
1111172015
09:51:11
1111152015
09:51:12
1141172015
09:51:13
1111172015
09:51:14

Date/Time

Touchscreen Kit: Disconnected Via Timeout | Expanded Annunciator: Not Optioned
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To expand the graph, change the 'View Start' and/or 'View Stop' times using the drop-down list.

&~ ACS 800 - Offline Datalog Vi

Individual channels of data can also be turned on and off for viewing by clicking

File  Cennection View Datalog Help

View Start ’11;-’11;"20151]9:51:1]5 hd

View Stop | 11/11/2015 08:51:14

11/11/2015 09:51:14
11/11/2015 09:51:15
11/11/2015 09:51:16
11/11/72015 09:51:17 .
11/11/201509:51:18
11/11/2015 09:51:19
11/11/2015 09:51:20
11/11/2015 09:51:21
11/11/2015 09:51:22 —
11/11/2015 09:51:23
11/11/2015 09:51:24 T
11/11/2015 09:51:25
11/11/2015 09:31:26
11/11/2015 09:51:27
11/11/2015 09:51:28
11/11/2015 09:51:29
11/11/2015 09:31:30
11/11/2015 09:51:31
11/11/2015 09:51:32
11/11/2015 09:51:33 -
11/11/2015 09:51:34
11/11/201509:51:35
11/11/2015 09:51:37
11/11/2015 09:51:38 —
11/11/2015 09:51:39
11/11/2015 09:51:40 e
114112015 09:51:41
11/11/2015 09:51:42 I
11/11/2015 09:51:43
11/11/2015 09:31:43 %

20 ! |

m

Walue

Datalog -> (channel name) to toggle the status.

a-| ACS 800 - Offline Datalog \

File  Connection View | Datalog | Help

View Start
View Stop

Select File

11/11/2015 08:!
1: LMV FUEL ACTUATOR
11/11/2015 08:!
2: LMV AIR ACTUATOR

3: LMV CURRENT SETPOINT

12”‘|7 4: LMV ACTUAL VALUE
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Editing Configuration Data

Configuration data for the Touchscreen Kit and Expanded Annunciator can be loaded or saved

from files by clicking View -> Offline Configuration.

File  Connection View  Offline Configuration Help

Touchscreen Kit | Email | Expanded Annunciator|

Tag: B-1 Site Name: Touchscreen Kit

Fuel 0 Tag: GAS Fuel O Flame Color:

Fuel 1 Tag: QIL Fuel 1 Flame Color:

Screen Saver Type: Screen Saver Time:
Auto Logout Time:

System Type: System Units:

Contral: [LM\«"&( Intemal Load Cortrol ']

Feedwater: [Disabled ~| VSD: [Disabled |

02 Display: [Calculate Dy -]

Expanded Annunciator: | Disabled =

Lock For Contral By Lead/Lag:

Color/Shape:

Touchscreen Kit: Disconnected! Expanded Annunciator: Disconnected

SCCInc.
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There are tabs for Touchscreen Kit setup, Email setup and Expanded Annunciator setup. Each
can be saved or loaded separately by clicking Offline Configuration -> Save To File or Offline
Configuration -> Load From File.

a-l ACS 800 - Offline

File

Connection

View

Tag: B-1

Touchscreen Kit Configuration

Touehscrsen Ki || Email | &

S

Fial A TaA-  RAC

Offline Configuration | Help
| Save To File » |
Load From File 3

Build USE From All  »

Email Configuration

Expanded Annunciator Configuration

Eiwal M Flama Calare Db me -

o ACS 800 - Offline

File Cennection View | Offline Configuration | Help
Save To Fil 3
Toushssreer Ki | Emai L
| Load From File 4 | Teuchscreen Kit Configuration
Tag: B § Build USB From Al » Email Configuration
Expanded Annunciater Configuration
Fuel 0 Tag: GAS Fuel 0 Flame Color: | Blue P g
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Saving Configuration Data To USB

To save all of the configuration files together in the proper folder directory for loading into the
Touchscreen Kit, first click View -> Offline Configuration and make sure the proper
configuration data is entered. Next, click Offline Configuration -> Build USB From All -> (6" or
10" Touchscreen Kit). Note that it is important to specify the correct touchscreen size.

a-l ACS 800 - Offline

File  Ceonnection View | Offline Configuration Iﬂ
Toucheceen ki | EntlIE Save To File »
"""""""""""""""""""""" Lead From File 3
Tag: Bl 5 Build USE From Al » 6" Touchscreen Kit fh
Fuel 0 Tag: GAS Fuel 0 Flame Calar; W 10" Touchscreen Kit

SCCInc. Page 127



Installation Instructions TS Series
Document No. TS-1100

Appendix - LMV5 Configuration for Modbus

The LMV5x controller must be properly configured for Modbus operation. Use the Select < and
Select > buttons to navigate up and down the screen and the Enter button when the desired
option is selected with the cursor. Use Esc to go back to the previous menu. When a parameter
needs to be changed, the Select < and Select > buttons allow the value to be changed and Enter
confirms the change. Press the Esc button to return after the change is made.

First, activate the Modbus port on the AZL (no password required):
1. Operation > OptgModeSelect > Type of Gateway = Modbus
2. Operation > OptgModeSelect > GatewayBASon
Note: Older AZL units may read 'GatewayDDCon' instead.

3. The AZL should now read 'Gateway Mode active'.

Next, set up the required parameters through the AZL (no password required):
5. Params & Display > Access w-out PW > AZL > Modbus > Address = 1
6. Params & Display > Access w-out PW > AZL > Modbus > Baudrate = 19200 bit/s
7. Params & Display > Access w-out PW > AZL > Modbus > Parity = no
8. Params & Display > Access w-out PW > AZL > Modbus > Timeout = 30s

Last, change the controller mode to allow Modbus operation (no password required):
Params & Display > Access w-out PW > LoadController > Configuration > LC_OptgMode =
IntLC Bus

The changes take effect immediately (no reboot required).

Page 128 SCCInc.



TS Series Installation Instructions

Document No. TS-1100

Appendix - LMV3 Configuration for Modbus

The LMV3x controller must have the OCI412.10 option installed in order to communicate with
the system via Modbus.

The service (heating engineer) password must be entered for these parameters to be accessed.
The default service password is 9876. If the password has been changed, please consult the
equipment OEM for the correct password.

To configure the LMV3x controller to communicate using Modbus, use the following procedure:

1.

© 0N

Hold down both the F and the A buttons until the display reads 'Code’, followed by a
string of seven underscores.

Use the + and - buttons to enter the password. Press ENTER (the button to the right of
the display) after each entry, and again once the complete password is entered. If the
password is incorrect, 'Error' will be displayed and the process will have to be restarted.
If the password is entered successfully, the screen will display 'Para’ and then '400: Set'
with the '400:' flashing.

Use the - button to navigate to '100: PArA', then press ENTER.

Use the + and - buttons to navigate to a flashing '141:". If this value does not read '1’,
press ENTER and then use the + and - buttons to change it to '1', then press ENTER to
confirm the change. This parameter activates Modbus. To return to the parameter
navigation, press the + and - buttons simultaneously (ESC). The display should return to
flashing '141:". This procedure will be used to change all parameters.

Change '142:' to 120. This parameter sets the timeout.

Change '145:"' to 1. This parameter sets the Modbus address.

Change '146:' to 1. This parameter sets the baud rate to 19200 bit/s.

Change '147:' to 0. This parameter sets the parity to none.

. When all the parameters are entered, press ESC in two successions to back up to the main

screen. The changes take effect immediately (no reboot required).
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Appendix - RWF55 Configuration for Modbus

The RWF55 must be properly configured for Modbus operation.

Use the up and down arrow buttons to navigate through the menus and the Enter button when
the desired menu is selected. Use Esc to go back to the previous menu. When a parameter
needs to be changed, the up and down arrow buttons allow the value to be changed and Enter
confirms the change. The parameter name will flash on the green display when the parameter
entry mode is entered. Press the Esc button to return after the change is made.

To configure the RWF55 controller to communicate using Modbus, use the following
procedure:
1. Press Enter to go into the menu list. The green display should read 'OPr'.
2. ConF > IntF > r485 > bdrt = 2 (19200 bit/s baud rate)
3. ConF > IntF > r485 > dtt = 30 (timeout)
4. ConF > IntF >r485 > Adr = 2 (address for load control applications) OR
ConF > IntF > r485 > Adr = 3 (address for feedwater applications)
5. Press Esc in four successions or until the parameter menus are completely exited. The
changes take effect immediately (no reboot required).
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Appendix - RWF40 Configuration for Modbus

The RWF40 must have the Modbus option in order to communicate with the system. The last
three characters of the part number must be 'B97' for Modbus to be optioned. If the last three
characters of the part number are 'A97', Modbus is not optioned.

To activate Modbus on the RWF40, make the following and parameters:

PwnNnpE

Press and hold PGM until the green display shows 'AL'".

Press and hold PGM until the green display shows 'C111".

Press PGM twice so that the green display shows 'C113".

Press the down arrow until the second red digit from the right flashes. Use the up arrow
to change this value to '7'. This parameter sets the baud rate at 19,200 bit/s.

Press the down arrow until the second red digit from the left flashes. Use the up arrow to
change this value to '2' if the RWF40 is being used as a load controller or to '3" if the
RWF40 is being used for a feedwater control. This parameter sets the Modbus address.
Press PGM. The red display should now read '0270' or '0370'. If it does not, use the down
and up arrows to adjust the value and then press PGM to confirm and save the values.
Press EXIT to return to the normal display. The changes take effect immediately (no
reboot required).
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Appendix - Yaskawa VSD (A1000 / V1000) Configuration for Modbus

The Yaskawa A1000 or V1000 VSD must be properly configured for Modbus operation.

To configure the Yaskawa A1000 or V1000 VSD controller to communicate using Modbus, use
the following procedure:

1.
2.
3.

Press the {, (down arrow) button until the red display reads 'PAr'.

Press the ENTER button again; the red display should read 'A1-01' with the 'A’ flashing.
Press the I (up arrow) button until the first digit in the red display flashes 'H', then press
ENTER.

Press the I (up arrow) button until the second digit in the red display flashes '5', then
press ENTER.

The red display should read 'H5-01', then press ENTER.

'H5-01" is the Modbus address. Enter '1F' using the arrow keys (= moves to the next
digit) then press ENTER. This sets the address to 31 but it is entered as a hexadecimal
number.

Press ESC until 'H5-01' is displayed again. Press the 1 (up arrow) button to navigate to
parameter 'H5-02' then press enter.

'H5-02' is the baud rate. Enter '04' using the arrow keys then press ENTER. This setting is
19,200 bit/s.

Press ESC until 'H5-02' is displayed again. Press the 1 (up arrow) button to navigate to
parameter 'H5-03' then press enter.

'H5-03' is the parity. Enter '00' using the arrow keys then press ENTER. This setting is no
parity.

10. Press ESC multiple times until the normal display appears.
11. Power cycle the VSD to apply the new settings.
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Appendix - RWF10 Configuration for Modbus

The RWF10 must have the Modbus option in order to communicate with the system. This is an
option card that is inserted into the controller when required.

To configure the RWF10 controller to communicate using Modbus, use the following

procedure:

1. Press the LEVEL (left-most) button until the red display reads 'CN-t'.

2. Press the LEVEL button again; the red display should read 'PSEL".

3. If the value of 'PSEL' does not read 'Mod', use the up and down arrow buttons to change
the value.

4. Press the MODE (loop with arrow on end, second from left) button to move to the next
parameter, 'U-No'. Change the value to '2' with the up and down arrow buttons and then
press MODE. This parameter sets the Modbus address.

5. Change parameter 'bPS' to '19.2' and then press MODE. This parameter sets the baud
rate to 19,200 bit/s.

6. Change parameter 'PRtY' to 'None' and then press MODE. This parameter sets the parity
to none.

7. Change parameter 'SdWt' to '20' and then press MODE. This parameter sets the timeout.

8. Once 'PSEL' is displayed again, press and hold the LEVEL button to save the changes. The

unit will reboot with the new parameters and the changes will take effect immediately.
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